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Welcome to RISO SC7500

Thank you very much for purchasing the RISO SC7500.

This manual provides various information ranging from basic operational description to
safety precautions and troubleshooting tips, to allow you to make the most use of the
SC7500.

We recommend, therefore, that you keep this manual within your reach and refer to it
before and during operation if required.

This document is intended for use by RISO, its authorised dealers and purchasers
of the equipment described herein. While every effort has been made to ensure the
accuracy of information contained in this document, RISO, its authorised dealers
and their employees shall not be held responsible for any inaccuracies it may
contain.

ALL SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE.

Warning
This is a Class A product. In a domestic environment this product may cause radio inter-
ference in which case the user may be required to take adequate measures.

MASCHINENLARMINFORMATION
Maschinenlérminformationsverordnung 3. GSGV, 18.01. 1991:
Der hichste Schalldruckpegel betréigt 70 dB(A) oder weniger gemiB ISO 7779.

Copyright © 1997 RISO Kagaku Corporation, JAPAN

Notes

(I) Reproduction or copying of this manual or any parts thereof without permission is
strictly prohibited.

(2) The contents of this manual are subject to change without notice due to product
improvements in the future.

(3) Although every effort has been made to ensure that the contents of this manual are
error-free, please contact us if you notice any errors or other points which
should be brought to the company’s attention.

(4) Item (3) notwithstanding, we cannot be held liable for any effects which have re-
sulted from following the instructions contained in this manual or from the opera-
tion of the machine.

* “Windows® Version 3.17, “Windows®95” and “Windows NT®” are registered marks of Microsoft Cor-
poration. It is referred to as “Windows 3.17 , “Windows 95” and “Windows NT” in this manual.
“MS-DOS®” is a registered mark of Microsoft Corporation.

“Macintosh®” is a trademark of Apple Corporation. It is referred to as “Macintosh” in this manual.
“Adobe®”, “PostScript®”, and “PostScript Logo” are trademarks of Adobe Systems Incorporated.

The other brand and preduct names may be registered marks or trademarks of their respective holders.

*® X ¥ ¥
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Introduction

2

This document, the SC7500 User Manual, is intended as an introduction and refer-
ence for any user of the SC7500. It is supplemented by the SC7500 Technical Adminis-
trator Manual.

Throughout the SC7500 User Manual, we assume that you are already familiar with
the basic operation of your computer. We will not explain how to work with keyboard
and mouse, how to start a program or how to interact with menus or dialog boxes. We
also assume that you know how to print from within your application program.

If you are in doubt about any of these general procedures, please review the manuals
of your computer, operating system or application program, or ask your Technical Ad-
ministrator or the person responsible for your system for help.

However, you do not need to be a computer expert. Everything that goes beyond the
knowledge of the average computer user will be described in greater detail, or we will
refer to the SC7500 Technical Administrator Manual.

The SC7500 User Manual presumes that your SC7500 has already been installed and
configured. All information necessary for installation and configuration is contained in
the SC7500 Technical Administrator Manual.

The person in your company who is responsible for computer and/or printer setup
and maintenance, referred to as the Technical Administrator or System Administrator,
should read both the SC7500 User Manual and the SC7500 Technical Administrator
Manual. Those who want “just to print” will find that the SC7500 User Manual best
" meets their information needs.

The user of an SC7500 will find this manual helpful to get quickly started. Take the
time to find out which paragraphs fit to your system environment and read them care-
fully. Overall, reading the user manual will save you time and enable you to take full
advantage of all features of the SC7500.

2.1
About This
Manual

SC7500 User Manual 2 Introduction
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2.2

SC7500 Features

2.2.1
The Computer
Side

The SC7500 is a raster image processor (RIP). This kind of device is a highly
specialised computer. The SC7500 is the RIP for use with the RISOGRAPH family of
Digital Printers.

The main task of a RIP is to compute the individual dots which constitute the contents
of a printed page. This page, or maybe a long document consisting of many pages, is
described by means of a page description language. The SC7500 understands the
PostScript (Level 2) page description language. Additionally, the Printer Command Lan-
guage (PCL, versions 5 and 5e) is a suitable language for printing on the SC7500.

The computer that you are using for creating documents connects to the SC7500 via
the serial port, the parallel port or the network port. The type of network used by the
SC7500 is called Ethernet. A SCSI interface is provided for scanning only.

Different “languages” may be spoken by the computers on a network, even if they
use the same kind of network, e.g. Ethernet. These languages are called network proto-
cols. The SC7500 uses two different network protocols: EtherTalk, which is the com-
mon network for Apple Macintosh computers, and TCP/IP, which is most widely used
among UNIX workstations. When using TCP/IP, communication will be one-way (uni-
directional) only.

10
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Many different RISOGRAPH models may be connected to the SC7500. The SC7500

2.2.2

automatically determines the resolution of the RISOGRAPH model used. There is no The RISOGRAPH

additional setup required.

In addition to printing, the SC7500 is also capable of scanning documents from the
RISOGRAPH’s scanner platen into your computer, provided that this feature is sup-
ported by your RISOGRAPH*. If an ADF (automatic document feeder) is installed, the
ADF may also be used for scanning with the SC7500.

Any image size that can be printed from the stand-alone RISOGRAPH may also be
printed using the SC7500. All original sizes supported by the stand-alone RISOGRAPH
are also supported by the SC7500 for scanning.

Screening techniques are used to print different shades of grey. In addition to conven-
tional screens, the SC7500 offers state-of-the-art Adobe Brilliant Screens FM screening
technology for PostScript documents.

The SC7500 can be completely controlled from the computer. SC7500 utility soft-
ware for different operating systems is provided for this purpose. Remote control in-
cludes choosing the Sort Mode if a sorter is installed.

* Please consult your RISO dealer for more information regarding RISOGRAPH
models that have a scanning function.

To avoid an electric shock and personal injury, the SC7500 enclosure may not be
opened except by a qualified service technician. The service technician must switch the
SC7500 off and unplug the mains supply before opening the enclosure.

It is most important to check the local supply voltage and to set the voltage switch on
the rear of the SC7500 according to the local voltage before attempting to connect the
SC7500 to the mains supply. See the hardware installation chapter of the SC7500 Tech-
nical Administrator Manual for information on how to set the voltage switch correctly
and how to connect the SC7500 to the mains supply.

Do not use the SC7500 in any way or for any purpose different from the description
in the SC7500 User Manual and SC7500 Technical Administrator Manual.

Side

2.3

& Safety

Warning

SC7500 User Manual 2 Introduction
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2.3.1 The following alert notices are used in this manual to alert a user to operate the
Alert Notices SC7500 correctly and prevent damage or injury.

N\ WARNING indicates a potentially hazardous situation which, if disregarded,
might result in death or sericus injury.

A\ CAUTION indicates a potentially hazardous situation which, if disregarded,
might result in injury or physicai damage.

23.2 /A\ WARNING
Installation @ Do not place water containers or metallic objects on the unit. If water drips inside the

unit or a metallic object drops inside it, it can result in a fire or an electric shock.

A\ CAUTION
@ Place the unit on a flat and stable surface. Injury might occur if the unit falls.

@ Do not place heavy objects on the unit. The objects might fall and cause injury.

@ Keep the object away from dusty or humid areas. Otherwise, a fire or an electric
shock might occur.

@ Unplug the power cord before moving the unit. Otherwise, the power
connector might be damaged and a fire or an electric shock might
occur.

12 2 Introduction SC7500 User Manual
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A\ WARNING

® Do not overload an electrical outlet or extension cord, nor damage
the power cord by placing heavy objects on it or pulling or bending
it. Otherwise, a fire or an electric shock might occur.

® Do not plug or unplug the power cord if your hands are wet. Other-
wise, an electric shock might occur.

A\ CAUTION

@® Do not pull the power cord but hold the plug itself when unplugged
it. Otherwise, it could become damaged and a fire or an electric shock
might occur.

/\ WARNING

® To prevent overheating and the possibility of fire, do not cover the air vents.

® Do not insert or drop any metallic material or flammable substance into the unit
through any opening. Otherwise, a fire or an electric shock might occur,

@® Do not disassemble or rebuild the unit by yourself. Otherwise, a fire
or an electric shock might occur.

® If the unit gets uncomfortably hot, smokes or smells bad, immedi-
ately turn off the power, unplug the power cord and contact your
service representative because a fire or an electric shock might oc-
cur.

@® If something drops inside the unit, turn off the power switch first,
then unplug the power cord and contact your service representative.
If you continue using it, a fire or an electric shock might occur.

® Unplug the power cord, if you do not use the unit for a long time.

2.3.3
Power
Connection

2.3.4
Handling
Precautions

SC7500 User Manual 2 Introduction
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Looking at the System

3

A typical system environment for the SC7500 consists of one or more computers, a
RISOGRAPH Digital Printer and the SC7500 which connects the computer(s) to the
RISOGRAPH.

A computer is necessary for creating or at least viewing and printing the documents.
Any computer may be used which can connect the SC7500 to one of its interfaces, and is
capable of producing appropriate page description data.

The computer consists of hardware (the “box” itself) and software (the programs
which run on the computer). There are different pieces of software necessary for creat-
ing the page descriptien that we need for printing:

One part of the software is the application program, e.g. a word processor like Microsoft
Word or a page layout program like QuarkXPress. The application program is what you
use for creating your documents.

The application program needs help to communicate with the computer’s hardware.
This help is provided by another piece of software called the operating system. Operat-
ing systems are, for example, Mac OS on the Apple Macintosh or MS-DOS and Microsoft
Windows on an IBM-compatible PC.

The operating system usually makes use of so-called drivers to provide services like
“write data to disk” or “show text on screen” to the application program. The most im-
portant driver for printing a document on the RISOGRAPH is the printer driver. For this
reason, special printer drivers which plug into some common operating systems come
together with your SC7500.

3.1
System
Overview

SC7500 User Manual 3 Looking At The System
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. We recommend the use of the drivers which are packed with the SC7500, to take full
advantage of all features of the SC7500 and the RISOGRAPH. If you prefer to use other
drivers, e.g. drivers which are part of your operating system, please refer to the docu-
mentation of your operating system. The SC7500 Installer CD-ROM contains some files
which are needed by these other drivers. However, for support of these drivers please
contact their supplier.

A: Ethernet cable
B: Video cable
C: Parallel cable
D: Serial cable
E: SCSl cable

Figure 3.1: System Overview

The SC7500 has several different options to connect to the computers. Please note
that not all configurations provide two-way communications, i.e. a back-channel for
displaying error messages cannot always be guaranteed. This depends on both the com-
puters’ hardware and operating system.

The serial and the parallel port allow only one computer be connected to it, but the
network port may connect to many computers at the same time.

The RISOGRAPH (also referred to as the printer) communicates with the SC7500 by
means of the video cable. While this cable is limited in length, the SC7500 will always
be placed near to the RISOGRAPH. The video cable transports image (video) data as
well as control and status information between the SC7500 and the RISOGRAPH.

16
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There is one fundamental difference between a dot matrix, laser or similar computer
printer and a RISOGRAPH: The printing process on a RISOGRAPH consists of two
consecutive steps. The first step is to generate the master, the second step is to print the
image from the master to the paper. Master making takes a few additional seconds, but
printing is high speed.
~ Looking from the computer to the RISOGRAPH, printing means to make a master
and set up the RISOGRAPH for printing. While the RISOGRAPH is printing, the SC7500
may be processing the next master if the job contains more than one page. This means
that the SC7500 is not constantly monitoring the RISOGRAPH at all times.

The SC7500 is essentially controlled by the computer. Nonetheless, three control
lights and one key are provided on a small operator panel at the front. They are useful to
control the basic operation of the SC7500.

BisH

Figure 3.2: SC7500 Operator Panel

3.2
SC7500
Operator Panel

SC7500 User Manual 3 Looking At The System
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3.2.1
Control Lights

There are three control lights on the lower right side at the front. Two of these lights
may be simply on or off, but the third one (the uppermost control light) may be illumi-
nated in three different colours and may also be flashing at two different rates.

3.2.1.1 The upper control light indicates the current state of the SC7500. The following table

describes each of the states:

Upper Control
Light

Colour

Lighting Condition

Status of SC7500

Meaning

Green

Green

Green/Yellow

Green/Red
Yellow

Yellow

Red

Yellow/Red

Yellow/Red

Red

Red

Flashing slowly
Flashing slowly

Flashing slowly

Flashing slowly

Flashing slowly

Flashing fast

Flashing slowly

Flashing fast

IDLE

BUSY

WAITING

INITIALISING
PRINTING

/F KEY

ERROR

ABORT

RESET

TEST PAGE

FACTORY
DEFAULTS

The SC7500 is idle and ready
to accept the next print job.

The SC7500 is currently
processing a print job,

The SC7500 is waiting for
additional data.

The SC7500 is initialising.

The SC7500 is making a
master.

The SC7500 is waiting for the
user to press the
RISOGRAPH’s I/F key.

An error has occurred. Further
information may be displayed
on your computer’s screen or
the RISOGRAPH’s operator
panel.

Red is also the initial colour
when the SC7500 is switched
on.

The SC7500 waits for the user
to either release the key to
abort the current processed job
or to keep the key pressed to
confirm a reset.

The SC7500 indicates that it
performs a reset and that the
key may be released.

The SC7500 waits for the user
to either release the key to
print a test page or to keep the
key pressed to confirm
restoring the factory defaults.

The SC7500 indicates that it
restores the factory defaults
and that the key may be
released.
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The middle control light is illuminated green if the SC7500 is switched on.

The lower control light is illuminated green if both the RISOGRAPH and SC7500
are switched on and are properly connected to each other. Please see the appendix for
help if the RISOGRAPH and the SC7500 are switched on but the lower control light is
not illuminated.

Pressing the key, which is located above the upper control light, has different effects
depending on when and for how long the key is held down.

If the key is pressed at the same time while the SC7500 is switched on, a test page
will be printed or all settings will be reset to their factory defaults, depending on how
long the key is pressed.

If the key is pressed while the SC7500 is busy, the current print job will be aborted or
the SC7500 will be reset which also depends on how long the key is pressed.

Note that the utility software allows the test page to be printed or to restore the fac-
tory defaults as well. Utility software will be described later in this manual and in the
SC7500 Technical Administrator Manual.

Make sure not to interrupt other users when pressing the key.

To print a test page, press the key, switch the SC7500 on and hold down the key until
the upper control light begins to flash red slowly, then release the key.

The SC7500 performs a self-test which is independent of any computer connected to
the SC7500. The test page confirms if testing was successful provided that the
RISOGRAPH is able to print.

To reset all settings to their factory defaults, press the key, switch the SC7500 on and
hold down the key. Keep on holding the key when the upper control light begins to flash
red slowly. After a while (approximately 10 seconds) the upper control light starts to
flash red faster. Now release the key.

All settings will be reset to their factory defaults. See the appendix of the SC7500
Technical Administrator Manual for a description of the factory defaults.

Note that the SC7500 automatically restarts when restoring the factory defaults. For
this reason, all fonts in memory will be deleted.

3.2.1.2
Middle Control
Light

3.2.1.3
L.ower Control
Light

3.2.2
Key

3.2.2.1
Printing
a Test Page

3.2.2.2
Restoring
Factory
Defaults
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3.2.2.3 To abort the current processed print job, press the key until the upper control light
Aborting starts to flash yellow and red slowly, then release the key.

a Print Job The current print job will be discarded.

3.2.24 To reset the SC7500, press the key and hold it down. Keep on holding the key when
Resetting the upper control light starts flashing yellow and red slowly.

the SC7500 Wait approximately 10 seconds until the upper control light begins to flash yellow

and red faster. Now release the key.

The SC7500 will perform a reset and any previously processed print jobs will be
aborted. Any fonts dewnloaded to memory will be deleted.

Please see the typefaces section for details about fonts. If a master is currently gener-
ated, the master will be completed before the reset.
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Before You Begin ...

4

We assume that the SC7500 has already been installed and configured as explained in
the SC7500 Technical Administrator Manual. To print the first page from your com-
puter, there are just a few things to do. '

On each computer, your System Administrator should have installed the appropriate
printer driver, together with a printer description file for the RISOGRAPH model used.
The PostScript printer driver and, sometimes, the application program uses printer de-
scription files to determine the distinct characteristics of the printer, e.g. supported paper
sizes.

We recommend the use of the printer drivers and, most importantly, printer descrip-
tion files which come with the SC7500. You may also use other printer drivers, but this
may limit access to several of the features described below and, sometimes, produce
unexpected results.

If you prefer to use the printer driver which is packed with your operating system,
you may do so, but note that we cannot provide technical support for drivers other than
our own. Therefore, if you have questions regarding the printer driver of your operating
system, please refer to the operating system’s manual. The SC7500 Installer CD-ROM
contains some files for use with these unsupported drivers.

4.1
Computer
Setup

4.1.1
What to Do?

SC7500 User Manual 4 Before You Begin...
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41.2
Just in Case ...

When the printer driver is installed, make sure that the driver is correctly set up for
the RISOGRAPH (i.e. for the RISOGRAPH’s printer description file), including setup
of the installable options of drum and sorter.

To verify your setup, select a paper size and print your first page from within a stan-
dard application program like SimpleText (Macintosh), WordPad or Write (Windows).
When you're satisfied with the results, print samples which are more complex from
within your usual application programs.

Do not use any options called “Collate” or “Collated Copies” which are provided by
some application programs. Using these options causes the RISOGRAPH to make anew
master for each printed page.

If anything doesn’t work as you would expect it from this description, ask your Tech-
nical Administrator for help.

If your operating system is not described here or if, for some other reason, your
computer is not set up according to this manual, you can still print with the SC7500 if
you use a PostScript or PCL printer driver.

If you have the choice, prefer a PostScript Level 2 driver. A PostScript Level 1 driver
will also work, but in most cases, using a Level 2 driver will improve performance.

Many PostScript printer drivers can make use of PPD (PostScript Printer Descrip-
tion) files. Use a PostScript driver in conjunction with a SC7500 printer description file
whenever possible.

There are no PPD files for PCL. Since the SC7500 emulates the HP LaserJet IIl and
LaserJet 4V printers, you may select a driver for one of these laser printers. Alterna-
tively, choose the driver for another PCL 5 or PCL 5e printer.

Pay special attention to the selection of paper size and feed direction when using
other printer drivers or printer description files. If you have to use the printer description
file of a different printer than your RISOGRAPH model, select a printer description file
of a printer which feeds the paper in the same direction as your RISOGRAPH (short
edge or long edge first). Keep in mind that the non-printable area along the edges of the
paper may vary when using different printer description files.

Normally, a printer driver automatically downloads fonts needed by a document if
they are not already stored on the SC7500. When using different printer description files,
the driver’s assumptions about fonts stored on the SC7500 may be wrong. For this rea-
son, you may need to manually download fonts to the SC7500.

Do not atternpt to use a printer driver which supports neither PostScript nor PCL! It
will not work.

22
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There are several different printer description files, the most popular one is called
PPD (PostScript Printer Description). The PPD file format is used by printer drivers and
application programs of different operating systems. PPD files consist of human-read-
able text and describe features like paper sizes, printable areas of the page, fonts, spe-
cific options like print finishing devices and more.

The Windows 3.x printer driver uses machine-only-readable files called WPD (Win-
dows Printer Description) which contain similar information. WPD files are not neces-
sary for printing with the SC7500: The SC7500 package includes an Adobe PostScript
printer driver for Windows which uses PPD files.

If you prefer to use the printer driver which comes with Windows 3.x, please note
that most features of the SC7500 are not available from within this driver and that we
cannot provide technical support for this printer driver.

QuarkXPress requires special attention regarding printer description files because it
uses its own. The name of QuarkXPress printer description files is PDF (Printer Descrip-
tion File). PDFs are provided for the SC7500 for both Macintosh and Windows. They
are usually stored in the folder/directory which contains the QuarkXPress program, newer
versions of QuarkXPress use a PDF subfolder/subdirectory.

The latest versions of QuarkXPress are alternatively able to use PPD files. This may
result in “double printers” in the QuarkXPress Paper Size dialog box if both the printer

driver’s PPD file and the installed PDF are recognised. If this happens, remove the cor- -

responding PDF from the folder/directory where it is installed. Renaming the file is not
sufficient to disable it.

4.1.3
Printer
Description
Files

SC7500 User Manual ' 4 Before You Begin...
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41.4
Apple
Macintosh

4.1.4.1
Printer
Selection

To select the SC7500 as your current PostScript printer, select the Chooser, located
in the Apple Menu. ’

Click the PSPrinter icon to select the SC7500 printer driver.

You may also select the LaserWriter 8 printer driver which is part of the Macintosh
operating system software. Please note that the SC7500 documentation refers only to the
PSPrinter driver and that we cannot provide technical support to you when using any
other driver.

Select the AppleTalk Zone where the SC7500 resides.

Type: | PostScript Printer v!

Calor S 2200

AL
Color % Pro

o
Imageyriter Lagserwriter 3008

Laser'driter 8 =% Background Printing

@ On O 0ff

® active
1 ingctive 754

StyleWriter 1200 Wl | AppleTalk

Figure 4.1: Chooser (Maciniosh)

The AppleTalk Zone depends on your particular network configuration. If you are
unsure of the correct AppleTalk Zone, ask your Technical Administrator.

Select SC7500 from the list of PostScript Printers. If the SC7500 has just been
switched on, there may be some delay until the SC7500 appears in the list.

If your SC7500 is currently not connected to the network and you want to print to a
file, choose Virtual Printer from the Type pull-down menu. In all other cases, select
PostScript Printer from the Type menu.

4 Before You Begin... SC7500 User Manual



If the SC7500 does not have a small icon next to it in the Chooser’s list of PostScript
printers, the printer driver has not yet been set up for a specific printer. Even if the icon
is visible, make sure that the driver’s settings for drum and sorter match the physical
setup of your RISOGRAPH.

We consider the printer driver setup to be done by your Technical Administrator,
therefore it is also described in the SC7500 Technical Administrator Manual. Neverthe-
less, make sure that the printer driver is correctly set up, in particular if you print on the
SC7500 for the first time or if the printer’s configuration has changed.

Note that printing from the Macintosh means printing PostScript data, there is no
PCL support for Apple Macintosh.

For printer driver setup, select Chooser from the Apple Menu. Select the SC7500 as
described in the previous section. Click Setup. Then, click Auto Setup in the next dia-
log box.

Provided that you do not set up a virtual printer, the printer driver searches for a PPD
file (PostScript Printer Description file) suitable for the SC7500. If it finds exactly one
PPD file for the SC7500, the driver will use this PPD for self-configuration.

If there is more than one PPD file for the SC7500 installed on your computer, the
printer driver displays a list of all PPDs for different RISOGRAPH models. In some
cases (e.g. if you have copied the SC7500 PPD files to a different directory than nor-
mally used for this purpose), the search may fail and you’ll have to select the PPD file
manually.

Select a PostScript Printer Description File:

SC?500-6R/1FP-400dpi
SC/S00-GR/IEP2600dpi

| (Sther 7ra )
(_cancei )
[ select |

Printer Model:
SC?500 GR/IFP 600 dpi

Figure 4.2: PPD File Selection (Macintosh)

41.4.2
Printer Driver
Setup

SC7500 User Manual 4 Before You Begin...
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In either case, the printer driver displays a dialog box to select a PPD file. For infor-
mation on a specific PPD file, click the file in the list in this dialog box. When you have
found the SC7500 PPD file for your specific RISOGRAPH model, click the PPD file,
click Select, then click OK.

PPD files are usually stored in System Folder:Extensions:Printer Descriptions.

Back to the Chooser, select the SC7500 and click Setup again.

Click Configure to get to the Installable Options dialog box.

i, 1 Current Printer Description File (PPD) Selected:
wheny  “SCY300-GR/IFP-600dpi”

instaliable Options:

Brum Size:
Sorter: Notlnstalie -

[ Cancel }[{ 9K ]]

Figure 4.3: Installable Options Dialog Box (Macintosh)

Make sure that the selected Drum Size corresponds to the drum installed in your
RISOGRAPH. Paper sizes which are displayed in the Page Setup dialog box depend on
the selected Drum Size. See the paragraph on print options below for details on how to
select a paper size for printing.

Furthermore, check if your RISOGRAPH’s configuration matches the Sort option,
Correct these settings if necessary.

After changing the Drum Size, always check the Paper option in the Page Setup
dialog box as described in the next section. If the new drum does not support the previ-
ously selected paper size, a new item called Other is selected. Change this setting and
select another paper size.

Click OK to complete the printer driver setup.

26 4 Before You Begin... SC7500 User Manual



IR

.. Prior to printing from within an application program, select Page Setup from the File
menu. There may be application programs which use a different name, but they will
provide a method to set up the page.

The Page Setup dialog box which appears on the screen is supplied by the printer
driver but is possibly extended by your application program. Try SimpleText to find out
what the plain Page Setup dialog box from the printer driver looks like.

PSPrinter Page Setup 2.3

Help |

Figure 4.4: Page Setup Dialog Box (Macintosh)

Use the Paper option to select the desired paper size. Available paper sizes depend
on the drum size selected from the Installable Options dialog box (see printer driver
setup above). '

You may click the page image box on the left to alternate between an image of the
appearance of the page and a numerical listing of the page dimensions in millimetres or
inches. To define a custom paper size, select Custom from the Paper options, then click
the page image box on the left and edit the paper dimensions.

PSPrinter Page Setup B.3.1 -
B s . A , :

Lagout:[ 1Up ] B

Reduce or o @
Enlarge: ‘- " THelp
Orientation: |) g:"]] 1% T% L—*‘—--J

Faper size (mm)
Width:
Height: 297.04

Marging (mm)
Left: 494
Top: 529
Right :
Baottomn:

Figure 4.5: Custom Paper Size {Macintosh)

4.1.4.3
Print Options

SC7500 User Manual 4 Before You Begin...
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There is no cross-check between a custom paper size and the size of the installed
drum. Any value will be accepted if it is printable with the largest possible drum for the
respective series of RISOGRAPH models. Therefore, please check that you enter a valid
custom paper size for the drum which you are currently using.

At first, leave the other options as they are:

The Layout option allows several pages of the document to be printed on one sheet
of paper. The pages will be automatically adjusted to fit.

Reduce or Enlarge rescales the page according to the scale factor. Scale factors may
range from 25% to 400%. The rescaled page will be aligned to the top left corner of the
paper.

Orientation distinguishes portrait and landscape pages. Please see the RISOGRAPH
setup section for an explanation of orientation versus feed direction. The Orientation
option is usually set up correctly by default.

Print options which are accessed by the Options button are described in the SC7500
Technical Administrator Manual.

Click OK to leave the Page Setup dialog box.

4.1.4.4 Select Print from the File Menu. The Print dialog box appears. This dialog box is
Printing Your also supplied by the printer driver and may have extra options provided by your applica-
Document tion program. The basic Print dialog box can be viewed without extra options from
within SimpleText.
Click Options to see the Print Options dialog box.
Print Options 8.3 [
Cover Page: @ Nene (O Before (O After Document
Print:| Color/Grayscale » | —
PostScript™ Ervors:_No Special Reporting w | «___H_EEP.._..]
Sort Mode:| Printer’s default w |
ABS Screening:| Printer's defaull w|
Print Speed:] Printer's defauil v | [ save |
Figure 4.6: Print Options Dialog Box (Macintosh)
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The Cover Page option may be used to add a cover page to your document. Until you
are familiar with the settings, the default None should be selected.

The Print option allows Calibrated Colour, Colour/Greyscale or Black and White
to be selected. The latter does not print any shades of grey and is provided for historical
reasons only. Select Colour/Greyscale which maps colours to grey levels.

You may want to change the PostScript Errors option from No Special Reporting
to Summarise on Screen. Note that this works only if Background Printing is turned
Off (in the Chooser). The Print Detailed Report option prints error reports on the
RISOGRAPH if necessary.

The lower part of the Print Options dialog box contains settings specific to the
RISOGRAPH. Choose Printer’s default for any of these options if you want to use
SC7500 settings which have been permanently set by means of the utility software. To
override permanent SC7500 settings, select the desired options as described below. Print
Options selected from the printer driver will be applied to the current document only,
they do not change permanent settings of the SC7500.

If there is a sorter installed, select the Sort Mode. Choose between Sort, Group,
Stack or NonSort. NonSort causes the sorter to use its output tray. Refer to the sorter’s
user manual for information about the different Sort Modes.

Select On from the ABS Screening options to set ABS as the default screen. Choose
Off to disable ABS Screening and to use conventional screening only. See the section
about screens for a comparison between conventional and ABS screens.

Setting the Print Speed option has the same effects as setting a print speed from the
RISOGRAPH’s control panel. Select Panel Settings to use the print speed which is
currently set at the RISOGRAPHs control panel or choose between Slowest, Slow, Stan-
dard, Fast and Fastest to set the desired Print Speed from your computer.

Print Density serves for the same purpose as the corresponding setting at the
RISOGRAPH's control panel. Choose either Panel Settings to use the print density
which is currently set at the RISOGRAPH’s control panel or select Lightest, Light,
Standard, Dark or Darkest to set a Print Density from your computer.

SC7500 User Manual 4 Before You Begin...
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Choose On from the Confidential Mode options to remove your document’s last
master from the drum immediately after printing. Select Off to disable Confidential
Mode and to leave the last master on the RISOGRAPH’s drum after printing.

When Auto Print mode On is set, the RISOGRAPH automatically generates and
prints a master. When Auto Print mode is Off, the RISOGRAPH generates a master,
prints one proof copy and stops until the interface mode is enabled again.

Choose the desired number of Proof Copies. Select any number between 0 and 9.
Proof copies will be printed in addition to the regular copy count which can be selected
from the Print dialog box.

Pause Before Next Master may be enabled while Auto Print (from the SC7500
Setup General) is enabled. If Pause Before Next Master is enabled, the RISOGRAPH
makes a master for the first page and prints all copies, including proof copies, of this
page. After printing, the RISOGRAPH stops and goes offline.

Use the Print Even/Odd Pages field to select Print All Pages, Print Odd Pages
Only or Print Even Pages Only.

Please refer to the section on duplex printing for further details on Auto Print, Pause
Before Next Master and Print Even/Odd Pages.

Select Yes or No from the Rotate 180° options to turn the printed page by 180 de-
grees.

Click Save if you like to store the selected options as default for subsequent docu-
ments.

Click OK to return to the Print dialog box.

Printer: “SC7500% ez v‘w‘éwj
Copies: Pages: ® Bl Dfrum:[:] Tu:l:‘

~Paper Source Bestination......... T
L@ AN O First feam @ Printer

v %QFile

Help }

Figure 4.7: Print Dialog Box (Macintosh)

In the Print dialog box, select the desired number of Copies. Note that the
RISOGRAPH will always generate one master for each page, print one or more proof
copies from this master and finally print the selected number of copies from the same
master. The number of proof copies may be selected from the Print Options dialog box
described above. Alternatively, it can be permanently set by means of the utility software
described later in this manual.

30
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The Pages option allows a range of pages to be entered if you do not want to print all
pages of your document.

Paper Source cannot be changed due to the RISOGRAPH's single paper feed tray.

Destination is set to Printer by default. At first, this should be left unchanged. You
may want to try the File setting later which enables you to produce PostScript or EPS
(Encapsulated PostScript) files. If you have set up a virtual printer in the Chooser, File
is the only possible Destination. See the next paragraph for details on how to print to a
file.

Click Print to start printing your document.

To print to a file, choose Print from the File menu of your application program.

Printing to a file works even if your SC7500 is not connected to the network. To print
to a file without network access, select Virtual Printer from the Type pull-down menu
of the Chooser. Make sure to set Type to PostScript Printer whenever the SC7500 can
be accessed from within your network.

From the Print dialog box, click File to select the Destination. Click Save. The Save
dialog box appears.

£ MACE.PS ¥ < Performa HO

-

Besktop
[ Mew [

cancel |
C)
Format:| PostScript™ Job w |

® ASCH @ Level t Compatible
O Binary ) Level 2 Only

Font inclusion: None w

Figure 4.8: Save Dialog Box (Macintosh)

4.1.45
Printing
to a File
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Select the destination folder and enter the Create File name. Choose from the fol-
lowing Format options:

PostScript Job produces a PostScript file which can be downloaded by means of a
PostScript file downloader, e.g. the SC7500 utility. The result is the same as when di-
rectly printing to the SC7500, except that the Cover Page option cannot be used.

EPS Mac Standard Preview creates an EPS (Encapsulated PostScript) file which
includes a 72 dpi monochrome preview image for display on Macintosh computers.

EPS Mac Enhanced Preview also creates an EPS file, but the preview is provided in
QuickDraw PICT format for better quality on most Macintosh models.

EPS No Preview generates an EPS file without any preview. This is the recom-
mended setting for EPS files which will be transferred to non-Macintosh computers.

Keep in mind that EPS files are limited to one page. ‘

When creating a PostScript Job, you may choose between ASCII or Binary data.
The Binary option prints faster because it produces less data. If you intend to transfer
the PostScript file via telecommunications services, these services must fully support
binary data transfer. If they do not, choose the ASCIH option.

Click Level 2 Only to produce PostScript Level 2 data suitable for the SC7500.
PostScript Level 2 data will often print faster than Level 1 data but can only be used on
PostScript Level 2 devices. For compatibility with PostScript Level 1 printers, select
Level 1 Compatible instead.

The Font inclusion pull-down menu offers several options for font embedding. Fonts
which are neither included in the file nor available on the SC7500 cannot be printed. On
the other hand, fonts significantly increase file size. Therefore, include only as many
fonts as needed.

If you assume all fonts of your document be available on the SC7500, select None to
omit all fonts. ,

Choose All to include all fonts in your file, provided that they are available on your
Macintosh.

Select All But Standard 13 to include all fonts except the core set of 13 PostScript
fonts which is supported by all PostScript printers. The core set of 13 fonts includes
Courier, Courier Oblique, Courier Bold, Courier Bold Oblique, Helvetica, Helvetica
Oblique, Helvetica Bold, Helvetica Bold Oblique, Times Roman, Times Italic, Times
Bold, Times Bold Italic and the Symbol font.

32
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All But Standard 35 includes all fonts in the file except the standard set of 35
PostScript fonts. 35 standard PostScript fonts are supported by many PostScript printers
including the SC7500. See the appendix for a list of the 35 resident standard fonts.

All But Fonts in PPD file includes all PostScript fonts which are not listed in the
PPD file.

All But Fonts in PPD file is the recommended setting for use with the SC7500,
except when you have all your fonts downloaded to the printer’s hard disk in which case
choose the None option.

After making your decision upon the options above, click Save to save your PostScript
file.

You may select the SC7500 as the current printer in two different ways. One way is to
set it up as default printer, which will be described in the next section.

If you use more than one printer and print to the SC7500 only from time to time, or if
you use both the PostScript and PCL printer drivers of the SC7500 on your computer,
you may want to select the SC7500 printer driver from within your application program
Just for a specific document.

In the latter case, the method for printer selection depends on your application pro-
gram. Most often, there is a Print Setup item in the File menu which allows a specific
printer to be selected. Sometimes, there is an item called Printer accessible from Print
in the File menu which serves the same purpose. Please refer to the manual of your
application program to find out how to select a printer.

Printer driver setup is also described in the SC7500 Technical Administrator Manual.
For this reason, the SC7500 printer driver should be already set up by your Technical
Administrator. Nonetheless, it is a good idea to verify a correct printer driver setup, in
particular if you print on the SC7500 for the first time or if the printer’s configuration
has changed.

4.1.5
Microsoft
Windows

4.1.5.1
Printer
Selection

4.1.5.2
Printer Driver
Setup
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4.1.5.2.1 There are several ways to get to the PostScript driver’s Printer Driver Setup dialog
PostScript box:

Driver Setup 1. (Windows 95) Click the Start button in the lower left corner of the screen. Select

Settings, then select Printers. In Printers, select the SC7500 printer icon. You
may want to select Set As Default Printer from the File menu. To continue, click
Properties from the File menu. The Properties dialog box appears.

2. (Windows 3.1x) From the Program Manager, double-click Control Panel which
is located in Main. Double-click Printers. In the Printers dialog box, select the
SC7500 from the list of Installed Printers. Click Set As Default Printer, if de-
sired. Click Setup.

3. (Windows 3.1x) Alternatively, double-click Print Manager which is located in
Main. Choose Install from the Options Menu. In the Printers dialog box, select
the SC7500 from the list of Installed Printers. Click Set As Default Printer, if
desired. Click Setup.

A variety of tabs is visible on top of the Printer Diriver Setup dialog box. Clicking
one of the tabs makes the respective file card the uppermost on the stack. To configure
the PostScript printer driver for your RISOGRAPH, click the Device Option tab from
Window 95 or the Features tab from Windows 3.1x.

4. (Windows NT 4.0) Enter the Document Properties dialog box from the Print of
your application and click the Advanced tab. Click the plus mark on the left of the
 Document Options and Printer Features.
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Make .sure that the selected Drum Size corresponds to the drum installed in your
RISOGRAPH. Furthermore, check if your RISOGRAPH’s configuration matches the
Sorter option. Correct these settings if necessary.

After changing the Drum Size, always refer to the Paper Size option on the Paper
file card (or for Windows NT 4.0, in the Document Properties box under Paper/Output).
If the new drum does not support the previously selected Paper Size, select anew Paper
Size which is supported by the drum.

If there is a sorter installed, select the Sort Mode. Choose between Sort, Group,
Stack or NonSort. NenSort causes the sorter to use its output tray. See the sorter’s user
manual for more information about Sort Modes.

Choose Printer’s default (or Use Current Settings in the printer) for any of the
features below if you want to use SC7500 settings which have been permanently set by
means of the utility software. To override permanent SC7500 settings, select the desired
options as described below. These selections do not change permanent settings of the
SC7500.

Select On from the ABS Screening options to set ABS as the default screen. Choose
Off to disable ABS Screening and to use conventional screening only. See the section
about screens for a comparison between conventional and ABS screens.

Setting the Print Speed feature has the same effects as setting a print speed from the
RISOGRAPH’s control panel. Select Panel Settings to use the print speed which is
currently set at the RESOGRAPH’s control panel or choose between Slowest, Slow, Stan-
dard, Fast and Fastest to set the desired Print Speed from your computer.

Print Density serves the same purpose as the corresponding setting on the
RISOGRAPH’s control panel. Choose either Panel Settings to use the print density
which is currently set at the RISOGRAPH’s control panel or select Lightest, Light,
Standard, Dark or Darkest to set a Print Density from your computer.

Choose On from the Confidential Mode options to remove your document’s last
master from the drum immediately after printing. Select Off to disable Confidential
Mode and to leave the last master on the RISOGRAPH’s drum after printing.

When Aute Print mode On is set, the RISOGRAPH auntomatically generates and
prints a master. When Auto Print mode is Off, the RISOGRAPH generates a master,
prints one proof copy and stops until the interface mode is enabled again.
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Choose the desired number of Proof Copies. Select any number between 0 and 9.
Proof copies will be printed in addition to the regular copy count which can be selected
from the Print dialog box.

Pause Before Next Master may be enabled while Auto Print (from the SC7500
Setup General) is enabled. If Pause Before Next Master is enabled, the RISOGRAPH
makes a master for the first page and prints all copies, including proof copies, of this
page. After printing, the RISOGRAPH stops and goes offline.

Use the Print Even/Odd Pages field to select Print All Pages, Print Odd Pages
Only or Print Even Pages Only.

Please refer to the section on duplex printing for further details on Auto Print, Pause
Before Next Master and Print Even/Odd Pages.

Select Yes or No from the Rotate 180° options to turn the printed page by 180 de-
grees.

Available printer memeory may be specified in the Windows 95’s Device Options
tab. It is recommended not to change the initial settings.

Before you leave the Printer Driver Setup dialog box by clicking OK, set up the
print options as described below.

Before you print from within an application program, enter the Properties dialog
box from Windows 95/NT 4.0, or enter the Printer Driver Setup dialog box from Win-
dows 3.1x as described in the previous section. In Windows 95, click the Paper tab.

A4R 150 B5-R

Multipurpose Tray

Figure 4.11: Properties Dialog box / Paper Tab (Windows 95)

4.1.5.2.2
PostScript
Print Options
{Windows 95)
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Select the Paper Size for the document setup. The user may select Custom Paper to
enter the dimensions of a non-standard Paper Size manually. You can define up to three
custom sizes. After choosing one of the Custom Papers, click the Custom button to enter
the paper size.

Figure 4.12: Custom Paper Dialog box (Windows 95)

Enter the custom Paper name and dimensions of a non-standard paper size manu-
ally. You can choose either Inches or Millimeters units. Check Transverse to rotate
your document 90 degrees.

Note that the user is responsible for entering a printable custom paper size. There is
no cross-check between a custom paper size and the size of the installed drum. All values
printable with the largest possible drum for the respective series of RISOGRAPH mod-
els are accepted.

The Layout option allows several pages of a document to be placed on one sheet of
paper. Document pages are automatically adjusted to the paper size. Click More Op-
tions and check Print page berder to print a frame around each page if you print more
than one document page per sheet.

38
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Orientation distinguishes Portrait and Landscape pages. Orientation versus feed
direction is described in the RISOGRAPH setup section of this Manual. The Rotated
check box allows the top and bottom of the page to be reversed in Landscape. Paper
Source cannot be changed due to the RISOGRAPH single paper feed tray.

Do not change the number of Copies on the Paper file card. The value of Copies
should always remain 1. Choose the number of copies directly from the application
program instead.

Click Unprintable Area if non-printable margins at the edges of the selected paper
are desired. No changes in default values are recommended because these values are
optimised for the best results with the RISOGRAPH.

Click the Graphie tab to set up graphic handling.

Figure 4.13: Properties Dialog Box / Graphics Tab (Windows 95)
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For the best print quality of images, Resolution should correspond to the resolution
of the RISOGRAPH, but a lower Resolution may accelerate printing. In most cases, no
change to the default Resolution value produce the best results.

Halftoning specifies values for the number of lines per inch (frequency) and the
angle of the pattern desired for halftone screens.

The Special option allows you to Print as a negative image or As a mirror image.
Negative image printing is useful only for black-and-white or coarse RGB images.

The Scaling option allows the page to be rescaled from 10% to 400%.

The Watermarks tab dialog box allows watermarks to be setup for documents. A
watermark will print at a certain place on each page of a document.

Figure 4.14: Properties Dialog box / Watermarks tab (Windows 95)
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Choose a watermark for editing from the Select a Watermark list.

Watermarks are generally printed on all pages of a document. Click On first page
only to print the watermark only on the first page.

Depending on the graphics in the document, printing the watermark In background
or As outline only may be selected.

For more information on the Watermark tab and the General and Fonts tabs, please
see the SC7500 Technical Administrator Manual. Details and PostSeript tabs will be
discussed later.

Click OK to exit the Properties dialog box.

From Windows 3.1x, you will find the Paper tab below: {Windows 3.1x)

PostScript

Multipurpose Trap
Ad

Figure 4.15: PostScript Printer Driver Setup / Paper Tab (Windows 3.1x)
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Select a Paper Size according to your document setup. You may select Custom Pa-
per if you want to enter the dimensions of a non-standard Paper Size manually. After
choosing Custom Paper, click the Custom Paper button to enter the paper size.

Figure 4.16: Custom Paper Dialog box (Windows 3.1x)

There is no cross-check between a custom paper size and the size of the installed
drum. Any value will be accepted if it is printable with the largest possible drum for the
respective series of RISOGRAPH models. Therefore, please check that you enter a valid
custom paper size for the drum which you are currently using.

At your first attemnpts, leave all other settings of the Printer Driver Setup dialog box
as is. Nonetheless, the other options from the Paper tab will be discussed below.

Please see the previous section for the Features tab and refer to the SC7500 Techni-
cal Administrator Manual for information on the Fonts, PostScript, Job Centrol and
Watermark tabs.

Use the Output Format option to select either PostScript for normal printing or
Encapsulated PostScript. Encapsulated PostScript (EPS) is only useful for printing
to a file and is restricted to one-page documents,

Paper Source cannot be changed because the RISOGRAPH offers only one paper
feed tray.

Orientation distinguishes Portrait and Landscape pages. Orientation versus feed
direction is described in the RISOGRAPH setup section. Rotated Landscape is similar
to Landscape but reverses top and bottom of the page.

The Scaling option enables you to rescale the page in the range from 10% to 400%.

Do not change the number of Copies on the Paper file card. The value of Copies
should always remain 1. The next section will show you a more convenient way to
change the number of copies directly from within your application program.

42
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Watermarks which are defined by means of the Watermark tab may be selected for
printing from the Watermarks list. Select First Page Only after selecting the water-
mark if you want to print it only on the first page of your document.

Select None from the Watermarks list for normal printing.

The Layout option allows several pages of a document to be printed on one sheet of
paper. The document’s pages are automatically adjusted to fit. Select Print Page Border
to print a frame around each page if you print more than one document page per sheet.

Select 1 page up/sheet for normal printing.

Click OK to exit the Printer Driver Setup dialog box.

From Windows NT 4.0, enter the Document Properties dialog box from the Print of
your application. Click the Page Setup tab.

SEZ2500 GRATE 600 dm Detault Document Properties Eﬁ%

Figure 4.17: PostScript Printer Driver Setup/Page Setup Tab
(Windows NT 4.0)

Select the Paper Size for the document setup.

Paper Source cannot be changed due to the RISOGRAPH single paper feed tray.

Do not change the number of Copy Count. The value of Copy Count should always
remain 1. Choose the number of copies directly from the application program instead.

Orientation distinguishes Portrait, Landscape and Rotated pages. Orientation versus
feed direction is described in the RISOGRAPH setup section of the SC7500 User Manual.
The Rotated option allows the top and bottom of the page to be reversed in Landscape.

{(Windows NT 4.0)
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To set up graphic handling, select the Advanced tab and click the plus [+] mark on
the left of the Graphic.

. SC7500 GRAFP 800 dpi Document Sett
:@ Paper/Qutput
5 Paper Size: <Latters
Orientation; <Potraity

1 Paper Soutce: <Autnmaticall Selecty

/] Scaling: <100 %

% TrueType Fort <Substitube with Device Fart
a2y Document Options )

Figure 4.18: PostScript Printer Driver Setup / Advanced Tab
(Windows NT 4.0)

For the best print quality of images, Resolution shouid correspond to the resolution
of the RISOGRAPH, but a lower Resolution may accelerate printing. In most cases, no
change to the default Resolution value produce the best results.

The Scaling option allows the page to be rescaled from 10% to 400%.

You can select the way to handle the TrueType Font.

If you want to print your document as a negative or a mirror image, click the plus
mark on the left of the Document Options and PostScript Options. You can select the
Mirrored Output and Negative Output.

Besides the above options, Metafile Spooling and Halftone Color Adjustment can
be set up in this tab.

Click OK to exit the Document Properties dialog box.
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To access the SC7500 PCL printer driver in order to.set it up, use the following
procedures:

Click the Start button in the lower left corner of the screen. Select Settings, then
select Printers. In Printers, select the SC7500 PCL printer icon. Click Properties from
the File menu.

A variety of tabs is visible on top of the printer driver’s dialog box. Clicking one of
the tabs makes the respective file card the uppermost on the stack.

Most of the tabs provide a Restore Defaults button which can be used to revert all
settings to the original values. From any one of the tabs, you may either click OKto save
your changes and leave the driver, click Cancel to leave without saving or click Apply to
save all changes without leaving the printer driver.

Select the Device Options tab to change the RISOGRAPH’s Print Deunsity.

RISO SC7500 (PCL] Propertics

Figure 4.19: PCL Printer Driver / Device Options Tab (Windows 95)

Select Lightest, Light, Standard, Dark or Darkest from the Print Deusity pull-
down menu.

4.1.5.2.3
PCL Driver
Setup for
Windows 95
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Choose the PCL printer driver’s Paper tab to select print media options from Win-
dows 95.

Large capacity

Speed Standard

Figure 4.20: PCL Printer Driver / Paper Tab (Windows 85)

Click the desired Paper size which must match the paper in the RISOGRAPH’s pa-
per feed tray.

Click either Portrait or Landscape to select the Orientation of the printed page.
Please refer to the section on the RISOGRAPH setup for a discussion of orientation
versus feed direction.

The Paper source cannot be changed because the RISOGRAPH does not have more
than one paper feed tray.

Select the print speed from the Media choice pull-down menu. Selecting the print
speed from the computer must be supported by your RISOGRAPH model, otherwise the
Media choice will be ignored.

Always select the number of copies from within the Print dialog box of your applica-
tion program. In this case, it is important to leave the Copies count of the printer driver’s
Paper tab as 1.

Click Unprintable Area if you want to see the non-printable margins at the edges of
the selected paper. It is recommended not to change the default values because they are
optimised for best results with your RISOGRAPH.

Click Other Options to select a Sort Mode, provided that a sorter is connected to
your RISOGRAPH. Select Printer’s Default from the Output Tray pull-down menu if
you want to use the default Sort Mode which is set by means of the SC7500 utility
software. Alternatively, select one of the Sort Modes Sort, Group, Stack or None. Please
refer to your sorter’s documentation for a description of the Sort Modes.

46
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To access the SC7500 PCL printer driver in order to set it up, use one of the following
procedures ;

1. From the Program Manager, double-click Control Panel which is located in
Main. Double-click Printers. In the Printers dialog box, select the SC7500 PCL
printer from the list of Installed Printers and click Setup.

2. Alternatively, double-click Print Manager which is located in Main. Choose
Printer Setup from the Options Menu. In the Printers dialog box, select the
SC7500 PCL printer from the list of Installed Printers and click Setup.

Enter the PCL Printer Driver dialog after selecting the PCL printer from the Print-
ers dialog box.

Besolution: iAo
A4 210 x 297 mm
Paper Source: |Uppe! Trap

Memory: | 1 MB

Paper Size:

Oaentation

@ Portrait Copies:

O ‘Landscape

Figure 4.21: PCL Printer Driver (Windows 3.1x)

Select desired print resolution in the Resolution pull-down menu.

Select desired Paper Size corresponding to the size of the paper in the RISOGRAPH
paper feed tray.

The Paper Source cannot be changed due to the RISOGRAPH single paper feed
tray.

Memory indicates the installed SC7500 memory. Select a value in the Memory pull-
down menu.

Click either Portrait or Landscape to select the Orientation of the printed page.
Please see the section discussing orientation versus feed direction in the RISOGRAPH
setup.

Always select the number of copies in the Print dialog box of the application pro-
gram. In this case, Copies count should remain at 1.

4.1.5.2.4

PCL Print Setup

for Windows
3.1x
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Click Options to select more options from Windows 3.1x.

Intensity Control
Darker Lighter

Hormal

O Line At

[ Print TrmeType as Graphics

Paper Quality: @eed Standard

Figure 4.22: PCL Printer Driver Options (Windows 3.1%)

Click None, Coarse, Fine or Line Art from the Dithering options to select graphic
quality.

Drag the Intensity Control scroll box to control the density of printed graphics.

Selecting the Print True Type as Graphics can save printer memory if a large num-
ber of True Type fonts are repeatedly used.

Paper Quality controls print speed. Use the pull-down menu to select the quality
appropriate for desired print speed.
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To set up the SC7500 PCL printer driver from Windows NT 4.0, enter the Document 4.1.5.25
Properties dialog box from the Print of your application. PCL Driver

Click the Page Setup tab to select the Paper Size for the document setup. Setup for

Windows NT 4.0

Figure 4.23: PCL Printer Driver / Page Setup Tab (Windows NT 4.0)

Paper Source cannot be changed due to the RISOGRAPH single paper feed tray.

Do not change the number of Copy Count. The value of Copy Count should always
remain 1. Choose the number of copies directly from the application program instead.

Orientation distinguishes Portrait and Landscape pages. Orlentation versus feed
direction is described in the RISOGRAPH setup section of the SC7500 User Manual.
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To set up graphic handling, select the Advanced tab and click the plus {+] mark on
the left of the Graphic.

1 Paper Size: <Ay
Qrientation; (Portraity
{4 Copy Count: <3 Copwo
4 _3,3 Graphic

g Document Options

{551 150 dots per inch

Figure 4.24: PCL Printer Driver / Advanced Tab (Windows NT 4.0)

For the best print quality of images, Reselution should correspond to the resolution
of the RISOGRAPH, but a lower Resolution may accelerate printing. In most cases, no
change to the default Resolution value produce the best results.

To set up more options, click the plus [+] mark on the left of the Document Options.

The Media option controls print speed. Choose between Lowest, Low, Standard,
High or Highest.

If there is a sorter installed, select the sort mode from the Paper/Output option.
Choose between None, Sort, Group or Stack. None causes the sorter to use its output
tray. See the sorter’s user manual for more information about sort modes.

To change the RISOGRAPH’s Print Density, select Lightest, Light, Standard, Dark
or Darkest from the Print Density option.

Besides above, Halftone Color Adjustment, Scan for Rules, Print Text as Graph-
ics and Metafile Spooling option are to be set up in this tab.

Click OK to exit the Document Properties dialog box.

50
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To print a document, choose Print from the File menu from within your application progran.

Select the desired number of Copies in this Print dialog box. Do not change the
Copies count on the Paper tab of the PostScript driver’s dialog box.

Note that the RISOGRAPH will always generate one master for each page, print one
or more proof copies from this master and finally print the selected number of copies
from the same master. The number of proof copies may be selected from the Device
Options tab of the PostScript driver’s Properties dialog box of Windows 95, or from the
Features tab of the PostScript driver’s Printer Driver Setup dialog box of Windows
3.1x or from the Document Options/Printer Features of the Advanced tab of the Docu-
ment Properties dialog box of Windows NT 4.0. Alternatively, it can be permanently
set by means of the utility software described later in this manual.

Click OK or Print (depending on your application program) to start printing your
document.

There are two different methods to print to a file from within Windows.

Some application programs provide a Print to File checkbox in the Print dialog box.
Check Print to File before printing. You will be asked for a destination directory and
filename.

If your application program’s Print dialog box does not have a Print to File checkbox,
you must temporarily change your printer connection as below:

From Windows 95/NT 4.0, click the Start button in the lower left corner of the screen.
Select Settings, then select Printers. From the Printers dialog box, click the SC7500
printer icon. Choose Properties from the File menu. Click the Details tab (Ports tab on
Windows NT 4.0) in the Properties dialog box. Choose FILE: from the Printer Ports
options to set up your computer for printing to a file.

LE> [Cieates & file on

Figure 4.25: Properties Dialog Box / Details Tab (Windows 95)

4.1.5.3
Printing Your
Document

4.1.5.4
Printing
to a File
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Using Windows 3.1x, double-click Printers from the Control Panel which is lo~ -

cated in Main. Select the SC7500 from the list of Installed Printers. Click Connect.
Select File from the list of Ports and click QK.

5C7500 GRAFP BOU dpi

Poris:

LOM4:  Local Poit Mot Present
EPT:
HEE
LPT1.DOS
LPT2.D0S

l’ Timeouts [seconds]

¥ Fast Printing Direct to Port

Figure 4.26: Connect Dialog Box (Windows 3.1x)

Your computer is now set up to print to a file. Before you print, click Setup to select
suitable settings from the printer driver’s setup dialog box. Make sure to restore the
previous settings when you want to print directly to the SC7500.
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From Windows 95, click PostScript tab and select the desired PostScript output

4.1.5.4.1

format from the pull-down menu among PostScript (optimize for speed), PostScript Postscript

(optimize for portability), Encapsulated PostScript (EPS) and Achieve format. Settings

Select either Download header with each print job or Assume header is down- (Windows 95)
loaded and retained.

507500 GR/IEP 500 dpi Praperties

Figure 4.27: Properties Dialog Box / PostScript tab (Windows 95)

Click Advanced for more options.

Figure 4.28: Advanced PostScript Options {Windows 95)

SC7500 User Manual
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Check Use PostScript Level 2 features to produce PostScript Level 2 data suitable
for SC7500. PostScript Level 2 data often prints faster than Level 1 data but can only be
used on PostScript Level 2 devices. To be compatible with PostScript Level 1 printers,
Use PostScript Level 2 features must be left unchecked.

Use the Bitmap compression box to change the bitmap compression if necessary.
Use this advanced feature only if you are using a Level 1 printer that is connected through
a communication port.

Use the Data Format box to specify the format in which to send data to the printer.
Note that not all printers support all formats.

Use the ASCII data option to send all data in Adobe Communication Protocol. ASCII
Data format allows the file to print on any printer.

Use the Tagged binary communications protocol option to send all data except
special characters in binary (8-bit) format over paralle] or serial ports.

Use the Pure binary data option to send all data in pure binary format. This is the
fastest format for printing, but can be sent only over the Ethernet.

Binary communication should be turned off if your printer supports binary commu-
nication and you are using the Archive Format option or creating an Encapsulated
PostScript (EPS) file that may be printed on a printer that does not support binary com-
munication. The Adobe Printer Driver does this automatically for you for the duration of
the print job.

Use Font tab to specify which True Type fonts should be replaced with built-in printer
fonts. Click Send True Type fonts to printer according to the font Substitute Table
to edit the Substitution Table.

Always use built-in printer fonts instead of True Type fonts or Always use True
Type fonts may also be selected.

Figure 4.29: Properties Dialog Box / Fonts tab {(Windows 95)
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From Windows 3.1x, click the Paper tab to select either PostScript or Encapsualated
PostScript from the Output Format options.

PostScript produces a PostScript file which can be downloaded by means of a
PostScript file downloader, e.g. the SC7500 utility. The result is the same as when di-
rectly printing to the SC7500. Encapsulated PostScript creates an EPS file which can
be embedded into other documents. EPS files include a PC-compatible (non-Macintosh)
preview and are limited to one page.

Set the Performance Options from the PostScript tab.

Figure 4.30: PostScript Printer Driver Setup / PostScript Tab
(Windows 3.1x)

{(Windows 3.1x)
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Check Use PostScript Level 2 Features to produce PostScript Level 2 data suitable
for the SC7500. PostScript Level 2 data will often print faster than Level 1 data but can
only be used on PostScript Level 2 devices. For compatibility with PostScript Level 1
printers, Use PostScript Level 2 Features must not be checked.

Choose between ASCII or binary PostScript data. The Send Data in Binary option
produces less data and therefore prints faster. If you intend to transfer your file via tele-
communications services, these services must fully support binary data transfer. If they
do not, leave Send Data in Binary unchecked.

Select either Optimise for Speed or Optimise for Portability from the PostScript
Performance options.

Furthermore, correct all settings for font embedding as necessary which are acces-
sible from the Fonts tab. Alternatively, you may want to check Do Not Download Fonts
from the Job Control tab. See the SC7500 Technical Administrator Manual for further
information about the Fonts tab or ask your Technical Administrator for help.

{Windows NT 4.0) From Windows NT 4.0, enter the Document Properties dialog box and click the
Advanced tab, and then click the plus mark on the left of the Document Options and
PostScript Options.

ocument (ptions

i Matalile Spooing: <Disableds

SRt e
@ Minored Dutput: <No»
@ Negative Dutput <No>
--@ Page Independence: <Ho>
Compress bitmaps: ¢<Yas>
% Generate Job Controf Code: <Yes>
.59 Send CTRAL-D Before Each Job: <Nlo>
“ot Send CTRLD After Each Job: ¢Yes>
4 Halftone Calor Adjustment
Figure 4.31: PostScript Printer Driver Setup / Advanced Tab
{Windows NT 4.0)

If you want to print your document as a mirror or a negative image, set the Mirrored
Output option or the Negative Output option <Yes>.

To compress bitmap images, set the Compress bitmaps option <Yes>. Use this ad-
vanced feature only if you are using 2 Level 1 printer that is connected through a com-
munication port.

Besides the above options, you can set up Page Independence, Generate Job Con-
trol Code and Send CTRL-D .
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Printing from within an MS-DOS application program is different compared to print-
ing from Windows or Mac OS. The reason is that printer drivers are not part of the MS-
DOS operating system. Instead, each application program uses its own printer driver.

For this reason, we cannot describe a general technique to install and set up a printer
driver, Furthermore, we cannot provide printer drivers for MS-DOS. To do so would
mean writing hundreds of printer drivers, one for each popular MS-DOS application
program.

However, this section provides a guide to setting up your computer for printing from
an MS-DOS application program to the SC7500.

The printer driver should be setup by your Technical Administrator. Reading this
section will help you understand several problems and limitations when printing from
MS-DOS.

It is iroportant when printing from within an MS-DOS application program to the
SC7500 that a PostScript or PCL printer driver must be installed. This will probably not
be a problem because nearly any application program provides PostScript and/or PCL
drivers. But if your application program does not supply a PostScript or PCL driver, you
will not be able to print.

Please see the documentation of your application program if there are PostScript or
PCL printer drivers and how they are installed. If you use more than one MS-DOS appli-
cation program, you need to install a suitable printer driver for each of them.

If you have the choice between different PostScript printer drivers, prefer 2 PostScript
Level 2 driver. A PostScript Level 1 driver will also work, but in most cases, using a
Level 2 driver will improve performance.

‘When using a PCL printer driver, note that the SC7500 supports PCL versions 5 and
Se. Since the SC7500 emulates the HP LaserJet III and LaserJet 4V printers, your best
choice is a driver for one of these laser printers. Alternatively, choose the driver for
another PCL 5 or PCL 5e printer.

4.1.6 -
MS-DOS

4.1.6.1
MS-DOS
Printing
Guidelines
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4.2
RISOGRAPH
Setup

4.2.1
Check This!

4.2.1.1
Sorter

When you select a printer driver, pay special attention to paper sizes and feed direc-
tions. Some MS-DOS application programs come with a variety of PostScript and PCL
printer drivers for several specific PostScript and PCL printers. Select a driver for a
PostScript or PCL printer with similar characteristics to your RISOGRAPH, i.e. a printer
which supports the same paper sizes and which feeds the paper in the same direction as
your RISOGRAPH (short edge or long edge first).

Only those paper sizes which are built into the printer driver will be selectable from
within your application program.

To avoid prints with missing fonts, select a driver for a PostScript or PCL printer
which supports the same resident fonts as your SC7500. Otherwise, you may have to
download missing fonts manually using the SC7500 utility software.

You will not be able to select a Sort Mode from within an MS-DOS application pro-
gram. Nevertheless, you may use a sorter for printing. Change the setup of the SC7500
by means of the SC7500 utility in order to set the desired Sort Mode.

Your RISOGRAPH’s setup must match the printer driver setup at any time. The
computer’s printer driver is not able to determine the RISOGRAPH’s configuration au-
tomatically. For this reason, the user must ensure a match between the RISOGRAPH
and the printer driver setup.

The setup of two installable options must be checked: Drum and sorter.

The Sort option is easily examined. The printer driver must know if there is a sorter or
not.

If there is a sorter installed and the driver set up accordingly, you can set the Sort
Mode by means of the printer driver.
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The second option, drum size, requires slightly more investigation. Most 4,212
RISOGRAPHEs are capable of using different drum sizes. Ask your Technical Adminis- Drum Size
trator if there is more than one drum for the RISOGRAPH at your site. If the answer is
yes, always allow for the possibility that somebody may have changed the drum without
telling you.,

Note that the SC7500 does not permanently monitor the RISOGRAPH for the cur-
rent drum size. The RISOGRAPH’s drum size is only checked once when the SC7500 is
switched on or restarted. Therefore, a restart of the SC7500 is required whenever the
drum size has changed.

Furthermore, the printer driver’s setting of the drum size is independent of the SC7500
and must be done manually by the user. Depending on the printer driver’s setting of the
drum size, different paper sizes will be displayed for paper selection.

See the computer setup section above to learn how to set up the printer driver.

4.2.2
Paper Size and
Feed Direction

Some confusion is often obscuring the terms “paper orientation” and “paper feed 4.2.2.1
direction”. Orientation
Orientation distinguishes portrait and landscape pages. It refers to the contents of a Versus Feed

page but is independent of the way how the page is printed. Portrait or landscape orien-

8e b e Direction
tation is defined by the user of the application program.

W | 4

Portrait Landscape

Figure 4.32: Orientation
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4222
Drum Size and
Paper Size

The feed direction may be “short edge feed” or “long edge feed”. Short edge feed
means that the printer feeds the paper with the short edge perpendicular to the feed
direction. Long edge feed means that the printer feeds the paper with the long edge
perpendicular to the feed direction. The feed direction is independent of the contents of
the page.

W~

Short edge feed Long edge feed

Figure 4.33: Feed Direction

There is a general rule for using different drum sizes in conjunction with the SC7500:
Drums for long edge feed or “R” sizes like A4-R or Letter-R treat all paper sizes as long
edge feed. Drums for short edge feed sizes like A3, B4 or Ledger (Tabloid) treat all paper
sizes as short edge feed. Printing A4-R, for example, on a A3 drum is not supported, but
printing A4 is supported instead.

By the way, no disadvantages will result from this behaviour. Printing speed with the
A3 drum remains the same for A4 or A4-R due to the constant circumference of a par-
ticular drum.
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. There is another general rule for printing with the SC7500: The user is responsible
for loading paper of the correct size in the correct feed direction.
Always make sure that the paper loaded into the RISOGRAPH’s paper feed tray
corresponds to the paper size selected from the printer driver.
It is important to load paper of the correct size and feed direction before the master is
made. Otherwise, the sizes of page and master do not match which may result in clipped
edges of the printed page.

The RISOGRAPH must be in interface mode to communicate with the SC7500. The
interface mode may be switched on or off by pressing a key on the RISOGRAPH’s
control panel. Please see your RISOGRAPH’s user manual for details on how to enable
and disable the interface mode.

If interface mode is enabled and the SC7500 is able to communicate with the printer,
the RISOGRAPH is “online”. If communication between the SC7500 and the
RISOGRAPH is impossible for any reason, the RISOGRAPH is “offline”.

If there is any error condition at the RISOGRAPH, e.g. the paper feed tray is empty
or the master disposal box is full, or when Auto Print mode is disabled, the RISOGRAPH
automatically goes offline. The user is required to eliminate the error or to load paper
and, after that, to manually switch the RISOGRAPH online again.

In case of an error condition, your computer will display a printer error message.
Note that some computer systems may not be able to display error messages, please ask
your Technical Administrator if you are in doubt.

The error message will indicate the nature of the problem. In most cases, the
RISOGRAPH displays a more detailed error message or indication on its main display.
After fixing the problem at the RISOGRAPH, make sure to enable the interface mode
again.

See the appendix for a detailed discussion of error messages.

4.2.2.3
Loading Paper

423
Online and
Offline
Operation
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4.2.4 The SC7500 needs to communicate with the RISOGRAPH at startup. Therefore, the
SC7500 RISOGRAPH must be connected to the SC7500 and must be switched on at the time
Test Mode when the SC7500 is switched on.

In case that the SC7500 is switched on before the RISOGRAPH, the SC7500 waits
for the RISOGRAPH for two minutes. If the RISOGRAPH is not switched on during
this time, the SC7500 starts up in test mode.

In test mode, the SC7500 is able to communicate via its ports but is unable to print.
Test mode may be useful to check or alter the setup of the SC7500 by means of the utility
software when a RISOGRAPH is currently not available. This mode may also be used to
investigate a technical problem.

When in test mode, the SC7500 must be restarted after connecting a RISOGRAPH in
order to print.
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Advanced Topics 9

Computer printers are digital machines. They distinguish “yes or no”, “on or off”, 5.1
“black or white”. There is nothing in between. Screens
The only thing they can do is to produce a black, i.e. ink-coloured dot or not. Assum-
ing white paper, “no dot” is equivalent to a white dot. Shades of grey cannot be repro-
duced due to limitations of the printing technology.
Screening is the technique to overcome this limitation. This section introduces two
different screening methods in rough outline and explains how to print different screens
with the SC7500 on a RISOGRAPH.

5.1.1

What’s an FM

Screen?

The RISOGRAPH is a Digital Printer and therefore only capable of printing black or 5.1.1.1
white dots. Fortunately, it prints a lot of these dots exactly side by side. A 400 dpi Conventional
RISOGRAPH prints, for example, 400 dots per inch. Therefore, a square of one inch by Screening

one inch consists of 400 times 400 or 160000 black or white dots.
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51.1.2
Screen
Parameiers

Let’s take a smaller square of 4 by 4 dots which equals a total of 16 dots. If these 16
dots are all white, the square is white. If they are all black, the square is black. But what
happens if 8 dots are white and 8 dots are black?

One edge of our small square is 4/400 inches long, this equals the tiny size of 0.01
inches or 0,254 millimetres. If there is a large area on the page filled with a regular
pattern of these small squares, side by side, the human eye’s perception of this area will
be grey.

Figure 5.1: Possible Grey Levels ofa Halftone Cell

Imagine, we can switch each of the 16 dots in the small square on or off, i.e. black or
white. This results in 17 different levels of grey, including black and white. Using a
regular pattern of the small squares instead of individual dots, we are able to reproduce
shades of grey. The small squares are called halftone cells.

There is an important drawback when using screening methods as described above:
The number of usable picture elements (pixels) becomes smaller. It is reduced from
former 400 black or white pixels per inch to 400/4 = 100 greyshaded pixels (or halftone
cells) per inch, in case of a 4 by 4 dot halftone cell. We need to know some parameters
which describe a screen to have a closer look at this effect.

As you already know, the number of possible grey levels depends on the size of each
halftone cell. Let’s use the term “size” for the number of dots along the edge of the
halftone cell, e.g. the size of a 8 by 8 dot halftone cell shall be 8. The number of possible
grey levels including black and white is the size squared plus one (see the example in the
previous section):

Number of possible grey levels = (Size of halftone cell? + 1
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The printer’s resolution is given in dpi or dots per inch. The term “dot” refers to the
dots of ink which can be physically printed by the machine. Resolution does not describe
a screen but has a certain relation to screen frequency.

Screen frequency is the number of halftone cells per inch. It is specified in Ipi (lines
per inch) and describes how fine or coarse a screen appears. Usually, you’ll wish to use
a “fine” screen, i.e. a high screen frequency. But the screen frequency is limited by the
printer resolution and the size of the halftone cell:

Screen frequency = Printer resolution / Size of halftone cell

Simply speaking, the finer the screen, the fewer levels of grey you can get at the fixed
resolution of your RISOGRAPH.

Another parameter which describes a screen is the screen angle, given in degrees.
When rotating the whole grid of halftone cells, the rows of halftone cells will be aligned
to a certain angle. This angle is called the screen angle. Most often, a screen angle of 45°
is used because it is the least noticeable.

In addition to these parameters, the shape of each halftone cell may differ. Except for
black and white, there are several possibilities to determine the black and white dots
inside the halftone cell for a given level of grey. This results in a particular shape of the
black area inside a halftone cell.

The most often used shape is round, others are elliptical, line or square. Some appli-
cation programs allow to define the shape.

In addition to conventional screening techniques, there is a completely different ap-
proach to creating screens. It does not rely on a regular pattern of halftone cells which
differ in the size of the black area inside.

Instead, frequency-modulated screens use black dots of small constant size but vary
the distance between the dots (their frequency). A dark grey is produced by a large num-
ber of black dots in a given area while a light grey consists of a small number of black
dots in that area.

Individual dots of FM screens appear to be randomly placed on the page and are
significantly smaller than conventional halftone cells. This results in finer details while
maintaining sufficient levels of grey. Note that there are no screen parameters like screen
frequency, screen angle or shape for FM screens.

The SC7500 provides Adobe Brilliant Screens technology for creating FM screens.

5.1.1.3
Frequency-
Modulated
(FM) Screens
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5.1.2
Screen
Selection

5.2
Typefaces

The SC7500 uses Adobe Brilliant Screens (FM screens) as default for PostScript
documents, provided that ABS Screening is switched On from within the printer driver
or utility software. Therefore, any PostScript docurnent which does not contain screen
settings will print with FM screens. When printing from within your application pro-
gram, do not set any screen frequencies, screen angles or shapes (or select “default” if
available) if you want to use FM screens.

To use conventional screening, set a specific screen frequency and screen angle from
within your application program. Screen setup differs among different application pro-
grams or may be impossible from within particular application programs. Please, refer
to the documentation of your application program on how to set up screening for your
document.

Note that certain parts of a PostScript document may contain screen settings which
are not valid for the whole document, particularly EPS (Encapsulated PostScript) files.
This enables you to create documents containing different screens on the same page.

If ABS Screening has been switched Off from within the printer driver or by means
of the utility software, the SC7500 uses conventional screens only.

Screen selection is not possible for PCL documents.

Typefaces, often also called fonts, are crucial to the appearance of any text-based
document.

Two different kinds of fonts are used in computer printers: bitmap fonts and vector
fonts. Bitmap fonts consist of dot-by-dot descriptions (images) of each character for
each size. Vector fonts consist of a mathematical description of each character’s outline.
The main advantage of vector fonts over bitmap fonts is that vector fonts may be scaled
to any size without loss of quality.

Furthermore, printer fonts (resident or downloaded) and screen fonts must be distin-
guished. Printer fonts are used by the SC7500 for printing while screen fonts are used by
your computer for on-screen display.

Most font issues are handled automatically by the printer driver. If you need informa-
tion about configuration options not covered by the following sections, please refer to
the SC7500 Technical Administrator Manual.
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Screen fonts are necessary to access and display the resident fonts of the SC7500 on

your computer. They are always bitmap fonts optimised for display on low resolution
computer screens.

Apple Macintosh screen fonts are supplied in a font suitcase which must be installed
in the System Folder. Microsoft Windows screen fonts are built into the SC7500 printer
driver,

After installing the screen fonts (or Windows printer driver), fonts can be easily se-
lected from within the application program. Please refer to the documentation of your
application software for information on how to select a particular font.

The application program does not only require a screen font to display the characters,
It also uses the font metric information (i.e. the spacing between characters) included in
the screen font for page make-up.

Therefore, screen fonts and printer fonts which do not match exactly may lead to
different results on screen and printed paper.

Always make sure to use corresponding fonts for display and printing.

Each font which is used in a document must be accessible by the SC7500 for printing.
In fact, a PostScript font is a PostScript program which creates the typeface on the SC7500.

The SC7500 uses vector fonts in Adobe Type 1 (PostScript) format. Furthermore, the
PostScript font formats Type 0, Type 3, Type 4, Type 3, Type 6, Type 9, Type 10 and
Type 42 may be used.

TrueType fonts are handled in a configurable way (Windows driver only). The printer
driver may automatically replace a TrueType font by the corresponding PostScript font.
Alternatively, the TrueType font may be wrapped into some PostScript code by the printer
driver. This makes the TrueType font a Type 42 PostScript font. Type 42 fonts can also
be processed by the SC7500.

5.2.1
Screen Fonts

52.2
Font Formats

5.2.2.1
PostScript
Fonts
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52.2.2
PCL Fonis

5.2.3
Resident Fonls

5.2.4
Downloaded
Fonts

5.2.4.1
Automatic
Download

The SC7500 processes scaleable PCL fonts in Agfa Compugraphic’s FAIS format
and bitmapped PCL fonts. Furthermore, TrueType fonts can be used.

PCL fonts may be downloaded to memory only. They cannot be downloaded to the
hard disk of the SC7500.

The SC7500 has several alternatives to access a font. For the user, the essential differ-
ence between these alternatives is how long the font persists in the memory of the SC7500.

Resident fonts are built-in typefaces which are accessible by the SC7500 at any time.
See the appendix for a list of resident fonts or print a font page or font sample page as
described in the utility software section.

When you use resident fonts in your document, the printer driver will only include
the font names in the PostScript cods which is sent to the SC7500. The font itself must
not be included because it is already stored on the SC7500. Therefore, resident fonts
print a bit faster than other typefaces.

The printer driver looks at the printer description file to determine if a font is resident
on the machine. The driver may also ask the SC7500 for available fonts, but this does not
work on computer systems which do not provide a two-way communication channel.

If the font is not already stored, it must be downloaded to the SC7500. There are
several options for doing this as below.

If the printer driver assumes that the font is not available on the SC7500, it automati-
cally downloads the font as part of the document.

The lifetime of the font is limited to the specific document. After printing the docu-
ment, the font will automatically be discarded.
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Under certain circumstances, it may be necessary to download a font manually.

If for any reason the printer driver assumes a font to be resident even if it is not, the
font is not sent as part of the document and the SC7500 uses “Courier” as default. Or, for
example, if you print a lot of documents using a specific non-resident font, you may
want to speed up printing by downloading the font once manually. This eliminates the
need for automatic font download each time you print.

The font’s lifetime depends on the destination of your download. You may choose to
download the font to memory or disk. When downloading a font to memory, it is acces-
sible for printing until you switch off or reset the SC7500. When downloading a font to
disk, it remains resident as long as it is not deleted.

How to manually download or delete a roman font is described in the sections about
the SC7500 utility and PCL printer driver. The PostScript font downloader is part of the
SC7500 utility software. PCL fonts can only be downloaded to memory, the font
downloader is part of the PCL printer driver.

Non-roman PostScript fonts, e.g. Japanese fonts like Kanji, are supported by the
SC75007 only.

Note that downloading a non-roman font to the SC7500J requires a particular
downloader software. This downloader is part of the font package. Always use the spe-
cific downloader software which comes with the non-roman font you want to download.
Please refer to the documentation of the font package on how to use the downloader.

There may be non-roman fonts which do not work with the SC75007 because they
use a downloader which is not compatible with the SC7500J.

Downloading multiple master fonts is generally not recommended.

The SC7500 supports manual duplex printing.

To print both sides of the paper, the user must set the respective mode by means of the
PostScript printer driver or utility software and turn the paper stack upside down manu-
ally. The Auto Print, Pause Before Next Master and Print Even/Odd Pages options
may help you to print oulti-page documents.

Please refer to the sections about utility software and printer drivers (PostScript only)
for a description on how to disable or enable Auto Print, Pause Before Next Master or
Print Even/Odd Pages.

5.2.4.2
Manual
Download

5.3
Duplex
Printing
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5.3.1
Auto Print

53.2
Pause Before
Next Master

53.3
Print Even/
Odd Pages

Auto Print is enabled by default. Auto print mode causes the RISOGRAPH to print
continuously until all copies of all pages are completed. This is the suitable setting to
print the top side only.

Auto print mode may be disabled for duplex printing. If auto print mode is disabled,
the RISOGRAPH makes a master for the first page, Prints one proof copy, stops and
goes offline. The user enables the interface mode of the RISOGRAPH manually to re-
start the printing process. After that, the RISOGRAPH prints the remaining proof copies
plus the selected number of copies.

After printing all copies of the first page, the RISOGRAPH makes the master for the
second page, prints one proof copy and stops until the interface mode is enabled again.
The cycle continues until all pages of the document are completed.

Disabling Auto Print allows manual duplex printing: When the RISOGRAPH stops,
the user may remove a paper stack from the paper receiving tray, turn it upside down,
load it into the paper feed tray and enable the RISOGRAPH’s interface mode again.

Alternatively, Pause Before Next Master may be enabled while Auto Print is en-
abled.

If Pause Before Next Master is enabled, the RISOGRAPH makes a master for the
first page and prints all copies, including proof copies, of this page. After printing, the
RISOGRAPH stops and goes offline. The user enables the interface mode of the
RISOGRAPH manually to make the next master and print all copies, including proof
copies, from this master.

The cycle continues until all pages of the document are completed.

Enabling Pause Before Next Master can be used for manual duplex printing: When
the RISOGRAPH stops, the user may remove a paper stack from the paper receiving
tray, turn it upside down, load it into the paper feed tray and enable the RISOGRAPH’s
interface mode again.

In contrast to disabling Aute Print as described in the previous section, the
RISOGRAPH stops and waits for the user before (not after) the next master is made.

In some cases, you may prefer to print even pages or odd pages only. To do so, select
Print All Pages, Print Odd Pages Only or Print Even Pages Only from the Print
Even/Odd Pages options.
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Anumber of utilities for each operating system are provided with the SC7500. These
utilities can be used to:

* Set up the environment of the SC7500.

» Download files to the SC7500.

» Capture images from the printer’s scanner,

Two utilities are provided for the Macintosh: the SC7500 Utility which is used for
the configuration and file downloading, and TWAIN Driver which is used for scanning
images from applications that support TWAIN.

The SC7500 utility is based on the Apple LaserWriter utility but has additional func-
tions specific to the SC7500.

To run the SC7500 utility, double-click the SC7500 Utility icon from the SC7500
folder of your Macintosh’s hard disk. Make sure to select the SC7500 in the Chooser
before starting the SC7500 Utility.

The LaserWriter utility consists of three menus: File, Edit and Utilities. The menus
are discussed in the following paragraphs.

Some of the menu items are not described in this manual because they are intended
for use by the Technical Administrator only. Improper use may cause malfunctions of
the SC7500 and even of your computer network.

Always ask your Technical Administrator before attempting to use any of the menu
items not discussed here. Refer to the SC7500 Technical Administrator Manual for a
complete description.

5.4
Utility Software

5.4.1
Apple
Macintosh

5.4.1.1
SC7500 Utility
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54.1.1.1 . The File menu contains file and font-related functions.

The File Menu Select Download Fonts from the File menu to download one or more fonts to the
SC7500. Select Printer to download fonts to memory or choose Printer’s disk(s) to
permanently install fonts on hard disk. The pre-selected disk SCSI Drive § cannot be

changed.

~Downioad to
) Printer

@ Printer's disk(s} £ SCS1 drive 0 }

Fonts to downinad:

%

[ Adg.. | | samape |

H

Cancel | || sownised |
R e s

Figure 5.2: Download Fonts (Macintosh)

Click the Add button to add a font to the Fonts to download list. If you decide not to
download a font you added before, select the font from the Fonts to download list and
click Remove. Finally, click Downlead to download the fonts from the Fonts to down-

load list.
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Select Display Available Fonts to display a list of fonts installed on the SC7500.
Choose Printer’s Disk(s) to display resident or permanently downloaded fonts. Choose
Printer to display fonts downloaded to memory.

Laseriliriter: SC7500

@& Printer's Disk(s} ) Printer
O eripier’s Foapt Fupansion Cardiy

Fonts on printer’s disk(s)
RuantGarde-Book
AvantGarde-BookObligue
fivantGarde-Demi
AvantGarde-Demidbligue
Boskman-Demi
Bookman-Demiltalic
Bookman-Light
Bookman-lightitalic
Courier

[ fielate }
e T

Figure 5.3: Display Available Fonts (Macintosh)

To delete a permanently downloaded font from the hard disk of the SC7500, select
the font from the Fonts on printer’s disk(s) list and click Delete. To delete fonts from
memory, sce Restart Printer from the Utilities menu.

Do not use Initialise Printer’s Disk from the File menu, it is not intended for use
with the SC7500.

Page Setup from the File menu displays the printer driver’s Page Setup dialog box.
The Page Setup dialog box is described in the paragraph on the Macintosh printer driver
in the computer setup section of this manual. Use Page Setup to set up the page before
printing the font catalogue, font samples or configuration page. Note that the page setup
is ignored when using SC7500 Print Page from the Utilities menu.

Choose Print Font Catalog to print a list of installed fonts. Select Print Font Samples
to print samples of installed fonts.

Once you have finished working with the SC7500 LaserWriter utility, select Quit
from the File menu.
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5.4.1.1.2 The LaserWriter utility offers a standard set of editing functions: Undo, Cut, Copy,
The Edit Menu  Paste and Clear.

Please refer to your Macintosh’s documentation if you need an explanation of the
editing functions.

54.1.1.3 Note that some of the items in the Utilities menu are disabled because they cannot be
The Utilities used in conjunction with the SC7500: Imaging Options, Calibrate Printer, Configure
Menu Communication, Remove TrueType, Change Zone, Print Density, Paper Handling

and Power Saving are greyed out and therefore cannot be selected.

Name Printer from the Utilities menu allows to change the printer name which is
displayed by the Chooser. Renaming the printer should be done by the Technical Admin-
istrator only.

Select Get Page Count to display the total number of pages printed on your SC7500.

Total number of
pages printed:

Figure 5.4: Get Page Count (Macintosh)
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To download a PostScript file to the SC7500, select Download PostScript File from
the Utilities menu. This feature allows to print documents which have been previously
saved as a PostScript file.

Select the desired PostScript file. Click Download to download the file. Do not use
Download PostScript File to download fonts. Use Download Fonts from the File menu
instead. .

Select Restart Printer to restart the SC7500. Click Restart to confirm the message
which appears on your screen. All fonts downloaded to memory will be deleted, but

fonts downloaded to disk will not be affected. Make sure not to disturb other users when

restarting the SC7500.

Change Zone changes your network setup. Do not use this menu iter, it is for use by
the Technical Administrator only.

Select SC7500 Print Page to print one of five different test pages. Choose Self Test
Page, Settings Page, Font List Page, Sample Page or Font Sample Page from the
Print pull-down menu. Click Print to print the selected page.

Printer name: SCY500

Print: | Seif TestPage |

[Cancel | | Print ||

Figure 5.5: SC7500 Print Page (Macintosh)

See the appendix of the SC7500 Technical Administrator Manual for a description of
the individual test pages. Note that the page size is independent of settings made in Page
Setup from the File menu.
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Click SC7500 Setup General to display general configuration information for SC7500
and RISOGRAPH.

Printer name: SCY¥500

Resofution {dpi): 400 u 400 Proof Copies: E@
insialied Memory: 16 M8 [ Auto Print

Free Uirtual Memory: 6727 KB rRecovery Mede:
Drum Size: A3 j :
Drum Coloun Black

[ Revert [cancei | [| setup |} |

Figure 5.6: SC7500 Setup General (Macintosh)

Configuration information includes Resolution, Drum Size and Drum Colour of
the connected RISOGRAPH and Installed Memory, Free Virtual Memory of the
SC7500.

The SC7500 detects the RISOGRAPH’s Drum Size at startup, therefore this infor-
mation may be out-of-date if somebody has changed the drum in the meantime. Installed
memory refers to the installed hardware. Free virtual memory denote resources of the
PostScript interpreter.

Furthermore, SC7500 Setup General allows to set the number of Proof Copies, to
disable or enable Aute Print mode and to set the Recovery Mode. Changing these
settings may interfere with the work of other users. Consult your Technical Administra-
tor before making any changes. Click Revert to restore the initial settings.
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The Recovery Mode determines the moment when the frame buffer of the SC7500 is
cleared to compute the next page.

Faster causes the SC7500 to discard the contents of the frame buffer immediately
after data transmission to the RISOGRAPH. The SC7500 begins to compute the next
page while the RISOGRAPH is making the master. If the master jams, the error cannot
be recovered and the page of the document must be printed later again.

If the Recovery Mode is Safer, the SC7500 stores the frame buffer until the master is
completed and the RISOGRAPH starts printing. It will take some more time until the
following page can be printed. If a jam occurs while making the master, the error can be
recovered and a new master can be made immediately.

SC7500 Setup Printing allows to set several parameters for printing. It is recom-
mended not to change these parameters except in coordination with the Technical Ad-
ministrator because other users will be affected. Click Revert to get back to the initial
values.

Printer name: L7500

7 Confidential Mode Copies:

{71 Pause Before Ment Master  Print Speed: l Standard v[
[IRotate 180° Print Density: |  Standard - |
> 0dd Pages Only Sort Mode: [_NonSort v ]

i (O Even Pages Oniy

| @® Al Pages :

[ Revert | [Cancel | ﬁ setup i]

Figure 5.7: SC7500 Setup Printing (Macintosh)

The number of Copies overrides settings included in a PostScript document provided
that Copies differs from 1. Changing the number of Copies may be useful if a document
is only available as a PostScript file for download and if the PostScript file does not
specify the desired number of copies.

Usually, you will print from within an application program and select the number of
copies in the Print dialog box of your application. In this case, it is important to leave the
Copies setting as 1.
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Confidential Mode is disabled by default, To enable Confidential Mode, check
Confidential Mode in the Printing dialog box. The last master of your document will
be immediately removed from the drum after printing if Confidential Mode is enabled.

Pause Before Next Master may be enabled while Auto Print (from the SC7500
Setup General) is enabled. If Pause Before Next Master is enabled, the RISOGRAPH
makes a master for the first page and prints all copies, including proof copies, of this
page. After printing, the RISOGRAPH stops and goes offline. Please refer to the section
on duplex printing for further details.

Rotate 180°, which is disabled by default, may be helpful if you are using a stapler.
Check Rotate 180° to turn the printed page by 180 degrees. This feature enables you to
select the opposite edge of the paper for stapling.

Use the Print field to select Odd Pages Only, Even Pages Only or All Pages, de-
pending on which pages you would like to print.

Check that Auto Print, Pause Before Next Master, Rotate 180° and Print are reset
to their default values for normal printing.

Setting the Print Speed or Print Density from the respective pull-down menu has
the same effects as setting print speed or print density from the RISOGRAPH’s control
panel. Choose between Slowest, Slow, Standard, Fast and Fastest for the Print Speed
and between Lightest, Light, Standard, Dark and Darkest for the Print Density.

The Sort Mode selected from the Sort Mede pull-down menu overrides settings
included in a PostScript document provided that it differs from NonSort. Available Sort
Modes are NonSert, Sort, Group and Stack. See your sorter’s user manual for infor-
mation about the sort modes.

It may be useful to set a Sort Mode if a document is only available as a PostScript file
for download and if the PostScript file does not specify the sort mode. It may also be
useful when printing from systems which do not use PPD (PostScript Printer Descrip-
tion) files for the SC7500, e.g. MS-DOS.

Make sure to reset the Sort Mode to NonSort for normal operation.

SC7500 Setup PostScript, SC7500 Setup Communication, SC7500 Initialise Disk
and SC7500 Restore Factory Defaulfs from the Utilities menu are for administrator
use only and therefore described in the SC7500 Technical Administrator Manual.
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The TWAIN driver is a driver format for acquiring images and it is supported by most
applications which can handle images. In other words, a TWAIN format driver can input
images using the same user interface from many different application programs.

Scanning application programs provide a menu itemn which is used to acquire a new
scan. After installation of the SC7500 scanner driver and, possibly, configuration of your
application program, the SC7500 can be accessed from within this menu. The name of
the menu item is usually Scan or Acquire, depending on your scanner application pro-
gram.

Configuration of the application program in order to use the SC7500 TWAIN driver
should be done by your Technical Administrator. Please refer to the documentation of
your scanning application program for details about how to scan an image.

Select Scan (or whichever name is used) from your application program to get to the
SC7500 Scan Control dialog box.

2 SC7500 Scan Control -

Settings Info

FPrevieW ~Region

A4 hd

w: 210 | u: [297 |

Units are Millimeires

r image Settings

Type: Dun e

Density: | Standard hal

{ Beguie | [ Cancel |

Figure 5.8: SC7500 Scan Control Dialog Box {Macintosh)

54.1.2
Scanning
from Your
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The SC7500¢ Scan Contral dialog box offers two menus called Settings and Info.

Enable Negative Image from the Settings menu if you want to get a negative image.
Choose either Millimetres, Inches or Pixels from the Settings menu to determine the
unit of measurement which is used to define a crop region.

Scanning and duo mode are not supported by all RISOGRAPH models. Select Status
from the Info menu to display RISOGRAPH status information. Since this information
is read from the SC7500 back to your computer, it also serves as a test for the SCSI
connection which is used for scanning.

The Info dialog box tells you if the connected RISOGRAPH provides Duo Mode
Suppert and Scanning Support. Furthermore, the Resolution of the RISOGRAPH is
displayed. Click OK to exit the Info dialog box.

Before you begin to scan an original, select the Image Settings from the SC7500
Sean Control dialog box:

Choose the Type of the original from Line, Photo and Duo. Note that Duo mode
cannot be selected if it is not supported by vour RISOGRAPH. Adjust the scanning
Density by choosing Lightest, Light, Medium Light, Standard, Medium Dark, Dark
or Darkest. Please refer to the RISOGRAPH’s user manual for a description of these
modes.

To scan an image, place the original on the RISOGRAPH’s scanner platen and click
the Scan button. When the RISOGRAPH has finished scanning, a Preview of the scanned
original is displayed. Even if the full-resolution scan is always black & white, the low-
resolution Preview is greyscale to improve readability.

Before transferring full-resolution image data from the SC7500 to your computer,
select a crop Region. There are three different ways to define a crop Region:

The first one is to edit a crop region in the Preview window by means of the mouse.
Move the mouse cursor to one corner of the desired region, click the mouse button and
drag the corner. Repeat with the opposite comer.

Alternatively, select a paper size from the crop Region pull-down menu. The selected
size refers to the markings at the RISOGRAPH's scanner platen.

The third way is to enter values for a Custom crop Region: Enter X and Y values to
define the upper left comer’s horizontal and vertical co-ordinates. Enter W and H values
to define the width and height of the crop region. The unit of the entered values may be
changed by means of the Settings menu.

Finally, click Acquire to transfer high-resolution black & white image data of the
defined crop region from the SC7500 to your computer.
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Three utilities are provided for Windows: the SC7500 Utility which is used for the
configuration and file downloading, TWAIN Driver which is used for acquiring images
from applications that support TWAIN, and RISO SCAN which can be used to scan
images as applications for scanning.

To execute the SC7500 utility, on Windows 95/NT 4.0, select Programs on the Start
menu, and select RISO and then SC7500 Utility, on Windows 3.1, double-click the
SC7500 Utility icon.

The SC7500 utility is the essential tool to set up the SC7500. It consists of five menus
called File, Print, Setup, Maintenance and ?, the help menu.

Some items from the Setup menu and the Maintenance menu are intended for use by
the system administrator. Improper use may cause malfunctions of the SC7500 and even
of your computer network. Therefore they are described in the SC7500 Technical Ad-
ministrator Manual only.

The File menu, the Print menu and the ? menu may be helpful for the Technical
Administrator as well as for any user of the SC7500. For that reason, these menus arg
described in this section of the SC7500 User Manual.

The printer driver must be installed and set up in order to use the SC7500 utility.

Some functions of the SC7500 utility require bi-directional communication, i.e. a
back-channel to send data from the SC7500 back to your computer. The ability to com-
municate in both directions depends on computer hardware and operating system soft-
ware.

If bi-directional communication is not supported, the SC7500 utility will display
Current instead of a read-back value. Furthermore, Current may be selected by the
user in certain situations instead of a value. This simplifies the procedure to change some
settings from a dialog box without touching the others. If you want to change one item in
a dialog box, select Current for all other items to ensure that they remain unchanged.

If you need to know the current settings of the SC7500 but bi-directional communi-

cation is not supported by your system, print the Settings Page from the Print menu of
the SC7500 utility.

5.4.2
Microsoft
Windows

5.4.2.1
SC7500 Utility
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54.2.1.1
The File Menu

The first thing to do when working with the SC7500 utility is to select the current
printer. Choose Select Printer from the File menuy, select the SC7500 from the list of
installed printers and click OK.

To download a PostScript file to the SC7500, select Download File from the File
menu. Downlead File allows documnents which have been previously saved as a PostScript
file to be printed. Choose the desired PostScript file from the dialog box which appears
on the screen. Click Open to start downloading the file.

Select Manage Fonts from the File menu to view, download or remove fonts of the
SC7500. Choose From SC7500°s Memory to display a list of fonts in memory or From
SC7500°s Disk to display a list of hard disk-resident fonts of the SC7500. Displaying a
font list requires bi-directional communication between your computer and the SC7500.

Please see the section on typefaces if you need more detailed information about the
differences between fonts in memory and on disk.

Note that fonts can only be removed if they reside on the From SC7500°s Disk. To
remove a font from disk, select the font from the displayed list of fonts and click Re-
move. If you wish to remove fonts from memory, the SC7500 must be restarted as de-
scribed below.

To download fonts to memory or disk, click Download. Select either From SC7500°s
Memory or From SC7500’s Disk, depending on the desired destination of your font
download. Add or Remove selected font files to or from the Fonts to download list.
Alternatively, click Add all to add all font files from the selected folder or click Remove
all to clear the Fonts to download list. When you have finished to build your list of
Fonts to download, click Download to start downloading all fonts from the list.

Choose Restart Printer from the File menu if you want to restart the SC7500. Click
Restart to confirm the message which appears on screen. Make sure that other users do
not currently use the SC7500 before you attempt to restart it. After restarting the SC7500,
all previously downloaded fonts will be removed from memory, but fonts on the printer’s
disk will not be affected.

Once you have finished your work with the SC7500 udlity, select Quit from the File
menu.
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The Print menu enables you to print six different built-in PostScript pages serving as
an aid for setup and test of the SC7500.

Select Self Test Page to print the results of a self-test of the SC7500.

Choose Settings Page to print information about the current setup of the SC7500.

Choose Font List Page to print a list of currently installed PostScript fonts of the
SC7500.

Select Sample Page to print a page containing text, artwork and images.

Select PostScript Font Sample Page to print a font list which shows each PostScript
font using the original typeface.

Select PCL Font Sample Page to print a font list which shows each PCL font using
the original typeface.

Note that the self-test page can also be printed without this utility and even without a
computer. Please see the SC7500 operator panel section for details.

The Setup menu is divided into five sections called General, Printing, PostScript,
Communication and Laser Jet Emulation PCL).

It is especially for use by the Technical Administrator to configure the SC7500, but
the General and Printing sections may also be useful for other users in certain cases.

Always ask your Technical Administrator before making any changes in the General
or Printing dialog boxes. Do not attempt to use the PostScript, Communication or
LaserJet Emulation (PCL) dialog boxes, they are for administrator use only.

Select General to enter the General dialog box.

1 Auto Select

Figure 5.9: General Dialog Box (Windows)

5.4.2.1.2
The Print Menu

5.4.2.1.3
The Setup
Menu
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The General dialog box displays the Resolution of the RISOGRAPH, the size of
Installed Memory of the SC7500 as well as Drum Size and Drum Colour of the
RISOGRAPH. Note that the SC7500 detects the RISOGRAPH’s Drum Size at startup,
therefore this information may be out-of-date if somebody has changed the drum in the
meantime.

Furthermore, the General dialog box allows the number of Proof Copies to be
changed, the Auto Print mode to be disabled or enabled and the Printer Language and
Recovery Mode to be set.

Choose the desired number of Proof Copies. Select any number between 0 and 9.
Proof copies will be printed in addition to the regular copy count which can be selected
from the Print dialog box of your application program.

When Auto Print mode On is set, the RISOGRAPH repeat a cycle of generating and
printing a master. When Auto Print mode is Off, the RISOGRAPH generates a master,
prints one proof copy and stops until the interface mode is enabled again.

Printer Language enables you to manually switch between the PostScript inter-
preter and the LaserJet Emulation (PCL) of the SC7500. If Auto Select is set which is
the recommended setting, the SC7500 will automatically determine if print data is in
PostScript or PCL format. Some rare cases, e.g. printing a PostScript program listing,
may require to set the Printer Language manually.

The Recovery Mode determines the moment when the frame buffer of the SC7500 is
cleared to compute the next page. \

Faster causes the SC7500 to discard the contents of the frame buffer immediately

‘ter data transmission to the RISOGRAPH. The SC7500 begins to compute the next
page while the RISOGRAPH is making the master. If the master jams, the error cannot
be recovered and the page of the document must be printed later again.

If the Recovery Mode is Safer, the SC7500 stores the frame buffer until the master is
completed and the RISOGRAPH starts printing. It will take some more time until the
following page can be printed. If a jam occurs while making the master, the error can be
recovered and a new master can be made immediately.

Jams of the master during the printing process cannot be recovered, independent of
the Recovery Mode settings. However, the user may eliminate a paper jam and print
additional copies if the paper jam did not damage the master.
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The Printing dialog box from the Setup menu lets you view and change the follow-
ing settings:

Figure 5.10: Printing Dialog Box (Windows)

The number of Copies overrides settings included in a PostScript document provided
that Copies differs from 1, the default. Changing the number of Copies may be useful if
a document is only available as a PostScript file for download and if the PostScript file
does not specify the desired number of copies.

Usually, you will print from within an application program and select the number of
copies in the Print dialog box of your application. In this case, it is important to leave the
Copies setting in the Printing dialog box from the Setup menu as 1.

Confidential Mode is disabled by default. To enable Confidential Mode, check
Confidential Mode in the Printing dialog box. The last master of your document will
be immediately removed from the drum after printing if Confidential Mode is enabled.

Rotate 180°, which is disabled by default, may be helpful if you are using a stapler.
Check Rotate 180° to turn the printed page by 180 degrees. This feature enables you to
select the opposite edge of the paper for stapling.
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Setting the Print Speed or. Print Density in the Printing dialog box of the Setup
menu has the same effects as setting print speed or print density from the RISOGRAPH’s
control panel. Move the respective slider to choose between Slowest, Slow, Standard,
Fast and Fastest for the Print Speed and between Lightest, Light, Standard, Dark or
Darkest for the Print Density. Alternatively, check Panel Setting to use those Print
Speed or Print Density settings which are currently selected at the RISOGRAPH’s con-
trol panel.

The Sort Mode selected in the Printing dialog box of the Setup menu overrides
settings included in a PostScript document if different from NonSort, the default setting.
Available sort modes are NonSort, Sort, Group, Stack and Current. Refer to your
sorter’s user manual for information about the sort modes.

It may be useful to set a Sort Mode if 2 document is only available as a PostScript file
for download and if the PostScript file does not specify the sort mode. It may also be
useful when printing from systems which do not allow PPD (PostScript Printer Descrip-
tion) files for the SC7500, e.g. MS-DOS.

Make sure to reset the Sort Meode to NonSort for normal operation.

Pause Before Next Master may be enabled while Auto Print (from the General
dialog box) is enabled. If Pause Before Next Master is enabled, the RISOGRAPH
makes a master for the first page and prints all copies, including proof copies, of this
page. After printing, the RISOGRAPH stops and goes offline. Please refer to the section
on duplex printing in the SC7500 User Manual! for further details.

Choose from Print Odd Pages Only, Print Even Pages Only and Print All Pages in
the Print Pages field, depending on which pages you would like to print.

Check that Pause Before Next Master and Print Pages are reset to default values
for normal printing.

54214 Online help is available by choosing Help from the 7 menu.
The Help Menu
To obtain information about the version of your SC7500 utility software, select About
SC7500 Utility from the ? menu.
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The TWAIN driver is a driver format for acquiring images and it is supported by most
applications which can handle images. In other words, a TWAIN format driver can input
images using the same user interface from many different application programs.

Scanning application programs provide a menu item which is used to acquire a new
scan. After installation of the SC7500 scanner driver and, possibly, configuration of your
application program, the SC7500 can be accessed from within this menu. The name of
the menu item is usually Sean or Acquire, depending on your scanner application pro-
gram.

Configuration of the application program in order to use the SC7500 TWAIN driver
should be done by your Technical Administrator. Please refer to the documentation of
your scanning application program for details about how to scan an image.

Select Scan (or whichever name is used) from your application program to get to the
SC7500 Scan Control dialog box.

- Preview ~ Region -

x [83 ] v
w (03] e[

Units are mm

Figure 5.11: SC7500 Scan Control Dialog Box (Windows)

The SC7500 Scan Control dialog box offers three menus called Settings, Status
and Help.

Enable Invert Image from the Settings menu if you want to get a negative image.
Choose either Millimetres, Inches or Pixels from the Settings menu to determine the
unit of measurement which is used to define a crop region.

5.4.2.2
Scanning
from Your
Application
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Scanning and duo mode are not supported by all RISOGRAPH models. Select Show
Status from the Status menu to display RISOGRAPH status information. Since this
information is read from the SC7500 back to your computer, it also serves as a test for
the SCSI connection which is used for scanning.

The Status dialog box tells you if the connected RISOGRAPH provides Duo Mode
Support and Scanning Suppert. Furthermore, the Resolution of the RISOGRAPH is
displayed. Click OK to exit the Status dialog box.

Choose Help from the Help menu to display information on how to use SC7560
Scan Control.

Select About SC7500 Scan Control from the Help menu to display the version number
of SC7500 Scan Control.

Before you begin to scan an original, select the Image Settings from the SC7500
Scan Control dialog box:

Choose the Type of the original from Line, Photo and Duo. Note that Duo mode
cannot be selected if it is not supported by your RISOGRAPH. Adjust the scanning
Density by choosing Lightest, Light, half Light, Standard, half Dark, Dark or Darkest.
Please refer to the RISOGRAPH’s user manual for a description of these modes.

To scan an image, place the original on the RISOGRAPH’s scanner platen and click
the Scan button. When the RISOGRAPH has finished scanning, a Preview of the scanned
original is displayed. Even if the full-resolution scan is always black & white, the low-
resolution Preview is greyscale to improve readability.

Before transferring full-resolution image data from the SC7500 to your computer,
select a crop Region. There are three different ways to define a crop Region:

The first one is to edit a crop region in the Preview window by means of the mouse.
Move the mouse cursor to one comer of the desired region, click the mouse button and
drag the corner. Repeat with the opposite comer.

Alternatively, select a paper size from the crop Region pull-down menu. The selected
size refers to the markings at the RISOGRAPH’s scanner platen.

The third way is to enter values for a Custom crop Region: Enter X and Y values to
define the upper left corner’s horizontal and vertical co-ordinates. Enter W and H values
to define the width and height of the crop region. The unit of the entered values may be
changed by means of the Settings menu.

Finally, click Acquire to transfer high-resolution black & white image data of the
defined crop region from the SC7500 to your computer.
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If you do not have a TWAIN-compatible scanning application program or if you want
to take advantage of your RISOGRAPH’s optional ADF (Automatic Document Feeder)
for scanning, use the SC7500 scan utility. The scan utility will save your scans as com-
pressed or uncompressed TIFF (Tagged Image File Format) files.

To start-up the SC7500 Scan Utility, on Windows 95/NT 4.0 select Program on the
Start menu, RISO and RISO SCAN. On Windows 3.1, double-click the SC7500 Scan
Control icon to launch the program.

The SC7500 Scan Control dialog box appears on your screen. Please refer to the
previous section for a description of the SC7500 Scan Control dialog box. The only
difference between the scan utility discussed here and the description above is the name
of the Acquire button which is called Save in the scan utility.

Scan your first criginal as you would do from within a scanning application program,
please see above for details. When you are ready to press the Acquire button, continue
as follows:

Click Save to enter the Save dialog box.

Path:  c:\tools95%viso

Basename: IMAGE_ l

¥ compressed TIF MNumber of originals: D

Figure 5.12: SC7500 Scan Utility / Save Dialog Box (Windows)

Enter the Number Of Originals you want to scan using the ADF. If you do not have
an ADF or if you want to scan one original only, enter 1. Note that the same crop region
will be used for all originals.

Enter the Drive and Path where you want to save your TIFF files.

Enter the Basename of the files which may consist of up to five characters. Resulting
filenames will be created from the basename, extended by two digits, a dot and the
filename extension TIF. If the Basename is TEST, for example, the resulting files will be
named TEST00.TIF, TESTO1.TIF and so on.

Check Compressed to save your scans as compressed TIFF files. Do not check Com-
pressed to save uncompressed TIFF files.

Click Save to save the first file and to start automatic scanning of additional origi-
nals.

Automatic scanning may be interrupted if a filename already exists or if the selected
Number Of Originals does not match the number of originals in the ADF.

5.4.2.3
SC7500
Scan Utility
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5.4.3
MS-DOS

5.4.3.1
SC7500 Utility

The SC7500 utility for MS-DOS closely resernbles the SC7500 utility for Microsoft
Windows.

The user interface of the SC7500 utility for MS-DOS can be controlled by keyboard
and mouse (optional). In the latter case a suitable mouse driver must be loaded on your
MS-DOS computer.

When using the keyboard, hold down the <ALT> key and press the highlighted letter
of the menu name to enter the menu. Press F while holding <ALT> to enter the File
menu, for example. Use the arrow keys to highlight a menu item and press <ENTER> to
select the highlighted itern.

Once you have entered a dialog box, use the <TAB> key to select a value to edit.

Alternatively, click the mouse to select menus and menu items,

The SC7500 utility for MS-DOS provides the same menus and functions as its Win-
dows equivalent except for the File menu.

The File menu offers Select Port instead of Select Printer to select the port where
the SC7500 is connected to.

Furthermore, the File menu offers Download Font instead of Manage Fonts:

i
5
i

Figure 5.13: Download Font (MS-DOS)
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Select Download Font from the File menu to download a font to the SC7500. Choose
one of the download destinations Memory or Disk. Select a font from the list of avail-
able fonts and click Downlead to start downloading the font.

Please refer to the description of the SC7500 Utility for Windows above to learn
about other menu items.

The SC7500 scan utility for MS-DOS is similar to the SC7500 scan utility for Win-
dows, but it does not provide a preview or user-defined crop regions.

The SC7500 scan utility for MS-DOS can be controlled by keyboard and mouse
(optional). In the latter case a suitable mouse driver must be loaded on your MS-DOS
computer.

When using the keyboard, hold down the <ALT> key and press the highlighted letter
of the menu name to enter the menu. Press S while holding <ALT> to enter the Settings
menuy, for example. Use the arrow keys to highlight a menu item and press <ENTER> to
select the highlighted item.

Once you have entered a dialog box, use the <TAB> key to select a value to edit.

Alternatively, click the mouse to select menus and menu items.

Figure 5.14: SC7500 Scan Utility (MS-DOS)

The scan utility offers three menus called Settings, Status and Help.

Enable Invert Image from the Settings menu if you want to get a negative image.
Choose either Millimetres, Inches or Pixels from the Settings menu to determine the
unit of measurement which is used to define a crop region.

5.4.3.2
Scan Utility
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Appendix

6

If your computer system provides a bi-directional communication channel to the 6.1
SC7500, the following messages may be displayed on your screen. General printer mes- Printer
sages are just for your information but error messages require specific user intervention. Messages

Please refer to the user manual of your RISOGRAPH for any information on
RISOGRAPH errors. Always make sure to enable the interface mode again after fixing
a problem with the RISOGRAPH.

If the action which is suggested below fails to eliminate the error, ask your system
administrator for help or refer to the SC7500 Technical Administrator Manual.

Printer message: idle 6.1.1
Meaning: The SC7500 is idle and ready to accept the next print job. General
Required action: None. Messages
Printer message: busy

Meaning: The SC7500 is currently processing a print job.

Required action: None.

Printer message: waiting

Meaning: The SC7500 is waiting for additional data.

Required action: None.

Printer message: printing

Meaning: The SC7500 is making a master.

Required action: None.
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6.1.2 Printer message: paper empty
Consumables Meaning: The paper feed tray of the RISOGRAPH is empty.
Errors Regquired action: Load paper.
Printer message: master roll empty
Meaning: The master material roll of the RISOGRAPH is empty.
Required action: Replace the master material roll.
Printer message: master disposal box full
Meaning: The master disposal box of the RISOGRAPH is full.
Required action: Empty the master disposal box.
Printer message: ink cartridge empty
Meaning: The ink cartridge of the RISOGRAPH is empty.
Required action: Replace the ink cartridge.
6.1.3 Printer message: paper jam
Print Engine Meaning: There is an error in the printing area of the RISOGRAPH.
Errors Required action: Check the RISOGRAPH for possible errors.
Printer message: master jam
Meaning: There is an error in the master-making area of the
RISOGRAPH.
Required action: Check the RISOGRAPH for possible errors.
Printer message: option error
Meaning: There is an error in an optional unit of the RISOGRAPH.
Required action: Check the RISOGRAPH for possible errors.
Printer message: offline, press printer UF key to continue
Meaning: The RISOGRAPH is offline.
Required action: Enable the interface mode on the RISOGRAPH.
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Printer message:
Meaning:
Required action:

Printer message:
Meaning:
Required action;

Printer message:
Meaning:
Required action:

Printer message:
Meaning:
Required action:

Printer message:
Meaning:

Required action:

Printer message:
Meaning:

Required action:

check printer control panel
The RISOGRAPH reports an unknown error.
Check the RISOGRAPH for possible errors.

fatal, check printer control panel
The RISOGRAPH reports a fatal error.
Check the RISOGRAPH for possible errors.

check printer power and cable connection

The RISOGRAPH is switched off or not properly connected.
Check if the RISOGRAPH is switched on and the video cable is
properly connected.

communication error, call service
The SC7500 reports a severe communication error.
Switch both the SC7500 and RISOGRAPH off and on again.

interface board error, call service
The SC7500 printer interface board test failed.

Switch both the SC7500 and RISOGRAPH off and on again.

serial number mismatch, call service

The SC7500 reports a wrong serial number of an internal
component,

Ask your Technical Administrator to call your local RISO
representative.

6.1.4
Fatal Errors
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6.2

Several errors are already covered by the printer messages section above. Some-

Common times, an error cannot be reported by the SC7300. This section lists some typical errors

Problems and  and explains what to do.

What to Do Please ask your Technical Administrator for help if the suggested action fails to fix
the problem or refer to the SC7500 Technical Adminisirator Manual for additional infor-
mation.

6.2.1 Problem: The upper control light of the SC7500 is illuminated red.

SC7500- Assumption: The SC7500 detected an error.

Related Required action: Check both computer and RISOGRAPH for any error mes-

Problems sages.

Switch both SC7500 and RISOGRAPH off and on again.

6.2.2 Problem: The desired paper size cannot be selected from the printer

Computer- driver.

Related Assumption: Drum size setup of the printer driver does not match your

Problems RISOGRAPH’s configuration.

Required action: Set up the printer driver as described in the computer setup
section.

Problem: The desired Sort Mode cannot be selected from the printer
driver.

Assumption: Sorter setup of the printer driver does not match your
RISOGRAPH’s configuration.

Required action: Set up the printer driver as described in the computer setup
section.
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Problem: The RISOGRAPH makes a new master for each printed page. 6.2.3
Assumption: Collate or Collated Copies is selected from within your RISOGRAPH-
application software. Related
Required action: Make sure to disable any Collate or Collated Copies options. Problems
Problem: The RISOGRAPH prints more copies than expected and prints
all copies of a page from the same master.
Assumption: The SC7500 is configured to print a large number of proof
copies.
Required action: Use the SC7500 utility to print the settings page and verify the
number of proof copies.
Ask your Technical Administrator to set the number of proof
copies.
Problem: The RISOGRAPH prints more copies than expected and uses
more than one master for the same page.
Assumption: The printer driver is set up to print a number of copies larger
than one.
Required action: Make sure to set the number of Copies to 1 in the printer driver.
Always set the number of Copies from within your application
program.
Problem: The edges of a printed page are clipped.
Assumption: The size of the master does not match the page size.
Required action: Make sure to load paper of the correct size and feed direction
before the master is made.
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6.3
Resident
Font List

6.3.1
Roman Fonls

This section lists all resident, i.e. built-in fonts of the SC7500.

AvantGarde-Book
AvantGarde-BookOblique
AvantGarde-Demi
AvantGarde-DemiOblique
Bookman-Demi
Bookman-Demiltalic
Bookman-Light
Bookman-LightItalic
Courier

Courier-Bold
Courier-BoldOblique
Courier-Oblique

Helvetica

Helvetica-Bold
Helvetica-BoldOblique
Helvetica-Obligue
Helvetica-Narrow
Helvetica-Narrow-Bold
Helvetica-Narrow-BoldOblique
Helvetica-Narrow-Oblique
NewCenturySchibk-Bold
NewCenturySchibk-BoldItalic
NewCenturySchibk-Italic
NewCenturySchlbk-Roman
Palatino-Bold
Palatino-Boldltalic
Palatino-Italic
Palatino-Roman

Symbol

Times-Bold
Times-BoldItalic
Times-Italic

Times-Roman
ZapfChancery-Mediumltalic
ZapfDingbats

98

6 Appendix

SC7500 User Manual



IXIRN

Index

A
ABS SCIEENING ...ovever it esse st eeeet et et e e stesstss e e s eeerenesossseaes 29, 36, 66
ACGUITE oo e s he e s taraessares s 79, 80, 87 — 89
ADF et et et ettt e ettt ereeseeee et eeeae et 11, 88
APPIBTAIK. ...ttt ettt sttt en e e st e sttt e et et esseene s eeseenn 24
ASCH ..ottt e st et e et et 32, 54, 56
AUO PHNE o s e s ee e 30, 36, 37, 61, 69, 70, 76, 78, 84, 88
B
BASENAIME ...oviicii ettt sttt ee e e et e es st e et s oo st e e e tes e s ee et ee e 89
BiNAIY .o et e et s e b a e aesanrene e e e 32, 54, 56
BItMaP COMPIESSION ...ttt st es et et et sees st es e renas 54
C
CHANGE ZONE .oviiieeiiiiei et ses et es st es st sae e e et ese s e s easseses st st s e esessaens 74, 75
CROOSEI ...ttt eaves e eree s se e e e s e s eenoseens 24— 26, 29, 31, 71, 74
COMPIESSEU ...ttt ettt esa s st eer et et e eeeeesee e oo eese et eese et eeseesesasas 89
Confidential MOTE ........ccoov ettt eere e s 30, 36, 78, 85
control light
GAEB/BITOT ...ttt ettt s et ee st et s e e s et s e esssse e s et e e eeseseesoss 17
POWBT ettt ees e s e ee et e e te s anberreesaeesreensesesannnne 17
POWET Of RISOGIAPN ...ovvvieii ettt ettt st ees e ee s s e eses et ereessresseesresas 17
COPIBS .vvrrere et e 22, 30, 37, 39, 42, 46, 47, 51, 76, 77, 84, 85, 97
CUSLOM PADET ...ttt escer e e ee et e s et 27, 28, 38, 42
D
Download
Download Font........ooevinieeeeeeeeeses e e, 22, 56, 72, 75, 82, 90, 91
Download POSESCDE FIE ...vvcevivveeruiecrerereeseiteteseee e eeees s cenesessessseseeseseeesneeeas 75
Drum
DIUM COlOU .ttt et e e eeso et es oot 76, 84
DIUM SIZE vt e e es s en e 26, 36, 59, 60, 76, 84, 96
DUO MOTE ...ttt e et e e eees 80, 88
E
B PG e e ettt e 31, 32, 42, 53— 66
EtNOIMEL ...t st ee ettt e et s e et et 10, 16, 84
BHNEITAIK ..ottt se et st er e s es st eee e ee e 10
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F
FIM SOTBEIIS oiviciiiiescccs ittt stes e consinessarcesnsscan e s s crsentas caaeestresntenssbesseensasassanaessn 65, 68
Font
fONT AOWIHOAUBE .1vi it s v er b bs s c bttt s raeecratr e s anbavasmanbreas 69
FONE INCIUSION 1 1oviri itk en s s eesssr s orebe s rebnessntvaresanesenanaesasenstssesrnberen 32
SCTEEN FONT oo et r e e s asbe s easaes e s et baeneny e shrserenaans 66, 67
TrUETYPE FONT e csirres e senrecnas s s rseee s rsessennsassanass 44, 87, 68
i
Installable OptOn ... e e ean 26, 27
INVEIT IMBOE oot sttt s e e s ssnesmensasne s 87, 91
L
Laserdet Emulation (POL) oo st siee s e oo eies 83, 84
M
Macintosh .oceee e, 1, 10, 15, 22 — 28, 30— 32, B5, 67, 71 —77, 79
MBITIONY Lot cnet s s e s e s e e e s an s re s s nnsarcen 47, 78, 82, 84, 91
MIOTR ODHONS i ceie st eciee s srr et e v rciatestessssesetasvansvantensontansansneassssssaansssunssassnnsnsense 38
MS-DOS oo crs e na e s e aas s e e ne v essenens 1, 15, 57, 88, 78, 86, 90, 91
N
Network
NBIWOTK DO ceeiieiieivieeic e iririeree e e enr s s e v sesreeatuseosveseressnnssan sreesanasnnssan 10, 16
NBIWOTK PrOTOCO ..ot seran e vt enes crenasn e s sessrnnsssresscessrnnesnasrennnnas 10
Number Of ONGINAIS ..ot s siresen s e s e s re e s sene s sr e sn o ernsearesesans 89
O
Optimise for POREDIRY .o v e ee s sse s s s veces e e e nsraaerenananas 56
Oplimise TOr SPBBU ..o e crre s st s e e s sa s gn e e s s e ennen 56
1017141 v (1o ] TR O SUUUR P 28, 39, 42, 43, 48, 47, 49, 59
OUIPUL FOMMAE ..ot s 42, 55
P
PABEI SOUMCE coiiciveeiiiceeeccrrcrar e reeneniis s bars s ssasnssas sseneesnssantssnas 31, 38, 42, 43, 47, 49
Parallel
PArAlE] POM et e et e e s e e e s e 10, 16
Pause Before Next Masier ..o vicincriesnvcsnsnvcnssssnsesesens 30, 37, €9, 70, 78, 86
PCL v cenerainrescnnesiems 10, 22, 25, 33, 45— 49, 57, 58, 66, 68, 69, 83, 84
P et rerer e et h s se skt e e as A beaan s ene s teeR e £ aas R e r bR e AR be et e nen e et eneen e naeneen s 23
PostScript ............ 1, 10, 11, 21 — 25, 29 - 35, 37, 41 — 44, 49 — 51, 53 — 58,
66— 69, 75— 78, 82 — 86
DOWEBT CONNIBCION .. v itraecercrernieieesintrerersesesssnriesiosasmesssssassasrastesesssressssutnsscsansntavessansasasns 12
POWEE SWITTT (oiiiiviiiiniiieiiririisiieieentsasse e stsseesessssseeessssessssesasssessssersnsstsnessesasnnsnesssransssases 13
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PP e e ettt 22, 283, 25, 286, 33, 78, 86 .
Print DBNSIY ..cvovvrieiceie i ceecereeresresaesre s esnss e 29, 386, 45, 50, 74, 78, 86
PHNEPAGES couvvititiiit ettt et e es et es st s esssne e st eseresaens 86
PriNt SPEEU ..ooeciviriceiece ettt ers e s s et 29, 38, 46, 48, 50, 78, 86
PrNTI0 FHlB oottt et e ettt ee e s s e esestens s enees 51
Printer Driver ...ovcevvceveeeeeenn, 18, 21 —29, 33— 35, 37, 41 —52, 54 — 58, 61,
66 — 69, 73, 81, 96, 97
Proof COPIBS u..iviiiiiieceie ettt sttt r ettt soenes s 30, 37, 76, 84
POPHINIEE ..ottt s e e s e e ettt et s e s en e ee e, 24
Q
QUEMKXPIBES 1..vovvieceririniet et sa ettt ee s e e s se e et oe e et e es s 15, 23
R
FRECOVEIY MOUE ...ttt ettt e 76, 77, 84
RREGION 1.ttt ettt ee e et ees et 80, 87 — 89, 91
RESEL ...ttt 18 — 20, 69, 78, 86
BeSOlULION .occei e e e e 40, 44, 47, B0, 85, 76, 80, 84, 88
REStAM ...t 19, 58, 62, 70, 73, 75, 82
ROEE 1807 ...ttt r e e v e n s ens 30, 37, 78, 85
S
SAVE it s s et s et 30, 31, 33, 45, 48, 75, 82, 89
8C7500
SC7500 INIHANSE DISK ....cvueerereecrveerieeceeietee s e s e s sseseseer s tseesns 78
SC7500 PrNt PAGE ....c.cucerreiernieiiseeicreeesctent st eeeessesesses e s ansseens 73,75
SC7500 Restore Factory DEfaults ...........ouieuiveiereieererierereeseseesseesssesessesssens 78
SC7500 3can Control ....veceriiininnire e eeeeeesseseessreessess oo 79, 80, 87 — 89
SC7500 Setup COMMUNICAHON ....vovvcvereececececieree et seees e eearsreresseerssseas 78
SC7500 Setup General.... ..o eeeeeeeeeeeeeeereeseeeeee e ee e eseorssns 30, 37, 76, 78
SC7500 Setup POSISCIDT ...vvveiveerircceseee st ee e s es s e s s ees s e en e 78
SC7500 SetuUP PrINtING ......ocoreirriririeieiiee et eeeeeseeveseseeresseesss s s ees e 77
SC7500 ULIIY ...oovereniierccriciniercesancesee e eeeee e enen s e snenesess s 71, 81, 86, 90, 91
SCANNG «.ecvieeciiticrirecrreir s ettt etetee s e e e et ee e e e eee et et ene e 40, 42, 44
scan
SCANMNET cortiiieriiiscsiirrmrcracrueinsrrasrossrsrressocserreseesnn e 11, 71, 79, 80, 87, 88
SCANNEL AIIVOE 1.ttt e e vetstesevesre st e ere e et ssessessaeaes 79, 87
SCANNING DBNSIY .....oveer et s e es s ev e eres s es e sesesneeas 80, 88
SCsl '
BSOS CADIB ...ttt ettt s e eeses e e esere e r s os e sss et esaeans 16
Serial
SOHAL CADIE ....vvire ettt ettt et e s er s seeas 16
serial port ....... e e e ter R e ieLEe e s Tt e e e nabrt e ta LR s b rnen srareeeretaensrrennrnnnes 10, 54
Sort
SO MOE .ooveveeercri e e 11, 29, 36, 46, 50, 58, 78, 86, 96
SOMEL ettt esreereer e 11, 22, 25, 29, 36, 46, 50, 58, 78, 86, 96
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TOPAP e ettt et ettt e et e etee s s e s et e e s ettt e e 10
TIUBTYDE ottt ettt ettt st e st ersres st et s e ansons 67, 68, 74
TWAIN et se et sttt e e ee et en e et emrenose et eans 71, 79, 81, 87, 89
TYPBTACE ..v ettt 20, 66 — 68, 82, 83
U

UNDN ettt et b et ee e et en et et e e e sesnseas et etn s sn st et enseas 10
UNDANTABIS ATBE ..ottt et e et s easens et st se et ene e 39, 46
v

WITHUBT PRINIBE 1ottt ee et e e st et s st eesatsss st eseasesesesonesssas 24, 31
w

WELBINIATK .....ivcreeiereris ettt et ee e este s et et e s eeesosetesteseseeeees 40 — 43
Windows................ 1, 15, 22, 23, 33 — 35, 37 — 57, 67, 81, 83, 85, 87, 89 — 91
WPD (Windows Printer DeSCHDHON) ........e.iveveeeeceeceeee oo eesees e eese e ens s s e ssnnas 23
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